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Dingo Interaction Report Form Insert Code: D Dingo ID: GBW11m & 6 other 
unidentified dingoes. 
 
Date (of Interaction): 01/01/14 
Location (of Interaction): 1km south of the Oaks 

Time (of Interaction 24hrs): 1800 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 1m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When vehicle persistently 

intervened 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     7 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age             6 

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: Only the male dingo first to approach 
the couple was tagged. 
 
d. Which ears were tagged Left 
    Details: Reported to be Orange in colour 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age: 27 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   private rental guest      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments dingo safe interpretative material encourages walkers to carry a stick. 
 
 
 
Detailed report of events: At 1800 on the 1/1/14 were walking on the beach 
approximately 1km south of the Oaks, where they were staying. They were approached by a dingo that 
eventually came close enough to to sniff his legs. The couple did not feel threatened and 
tolerated this behaviour. noticed that the dingo had an Orange tag in its left ear. Soon after this, 
Six other dingoes came from the dunes, ran towards the couple and surrounded them. moved his 

into the water and threw his water bottle at the Orange tagged dingo. The dingoes backed away 
briefly and thought he and his would be safest in the water, so they began moving into the 
water further. The dingoes continued to attempt to surround the couple, so they moved deeper into the 
water. were eventually neck deep in the water. The dingoes were apparently 
attempting to swim out to them, however could not get through the waves, according to 
 
After 5 minutes the dingoes lost interest and ran back onto the dune. began exiting 
the water, however once they were in waist deep water the dingoes "Made a beeline" for the couple 
once more. The dingoes again pushed the couple into neck deep water. After another 5 minutes the 
dingoes began losing interest. At this point a man driving a white Prado noticed what was going on and 
began driving at the dingoes as they exited the water. This allowed the couple to exit the water and hop 
into the car, where they were taken back to their accommodation at the Oaks.   
 
 
Additional comments and notes: There have been multiple interactions in this vicinity involving an 
Orange tagged male dingo displaying this behaviour. This dingo has been previously identified as 
GBW11m.  
 
AMMENDED 10/9/14 by 7026480 - Orange tag male dingo amended to GBW11m after review of 
information and consultation with staff. Interaction area, behaviour, group number, and description are 
consistent with GBW11m.   
 
 
Action taken: Interviewed and briefed as well as other guests staying at their accommodation. 
Conveyed that dingoes must be deterred when they approach anyone closely and to carry a stick when 
walking outside of accommodation. Circulated report. 
 
 
 
Proposed further action: Continue to provide dingo safety briefings to Guests on or close to their 
arrival at the Oaks accommodation.  
 
 
Faxed/emailed date:  3/01/14                                           Reporting Officers details:  7026936 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unid male dingo 
 
Date (of Interaction): 5/01/14 
Location (of Interaction): Burad CZ northern 
section 

Time (of Interaction 24hrs): 04:30 
Reporting Officer/s details: 75601551 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Unknown (3rd hand report) 
Address: Unknown 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The camper remained calm, the camping area was reported to be clean of rubbish and food. 
All information received in this report was taken "third hand", the family camping in this area was due to 
leave the Island that morning and no details of the man involved was known. A neighboring camp site 
reported the incident to me while briefing and patrols. 
 
 
 
Detailed report of events: Male camper about 40 yrs of age was having a cup of tea about 4.30am 
Sunday 5/01/14. He had his head down making his tea, looked up and saw a large male dingo very 
close to him approximately 1.5m away . He had a large torch handy and swung it at the dingo in an effort 
to scare him away. The dingo did not move, instead showed dominant behaviour towards the man and 
possibly growled at him. After the camper grabbed a spare tent pole and threatened the dingo, it 
eventually left the camping area.  
 
 
 
 
 
 
 
Additional comments and notes: Identification of the dingo was unknown, but the man believed it to 
be an adult male dingo. 
 
 
 
 
 
Action taken: Incident reported to ranger's 7027330 and 7027202, incident report draft completed and 
sent to 7026466 for finalising. 
 
 
 
 
 
Proposed further action: Continue to monitor this area and provide education briefings.  
 
 
 
 
 
Faxed/emailed date:  9/1/2014                                Reporting Officers details:  7027848 
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Dingo Interaction Report Form Insert Code: D Dingo ID: 2 unidentified males 
 
Date (of Interaction): 8/1/14 
Location (of Interaction): Wongai CA Beachfront 

Time (of Interaction 24hrs): Between 08:30 & 09:00 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) <1m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Jogger picked up by passing 

vehicle 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     6 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 2             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: 1 male dingo had a tag (no ID 
confirmed) and no tag noticed in the other male 
dingo 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Sunrover Tours 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Two Sunrover tour vehicles were travelling along the Eastern Beach when 
they observed a male visitor jogging on his own.  The tour leaders saw 6 dingoes in the area, 2 adult 
males (larger) and 4 juveniles (smaller).  The two adult dingoes started to chase after the jogger, nipping 
at his heels, and forced him into the ocean.   
The Sunrover tour guide (Reg) shouted out to the jogger not to go into the water as the dingoes love it, 
before stopping and picking up the jogger in his vehicle.  The jogger was dropped at Eurong. 

(Sunrover tour guide) said that one of the adult male dingoes was tagged, but could not make out 
the colours, and she did not notice whether the other adult was tagged or not. 
No details of the jogger were obtained by Sunrover tour guides. 
 
 
 
Additional comments and notes: There is a known family pack in the Eurong area that are seen 
regularly on the beach between Govi CA and Cornwells CA.  It is possible that the two dingoes involved 
in this incident are RYY07m and PuWW12m. 

stated to QPWS staff that she had been advised by her colleague not to report the incident to 
QPWS as "they will just go out and shoot them all". 
 
 
 
Action taken: Interview conducted and report generated.  RIC NRM informed. 
 
 
 
Proposed further action:   Patrols to be conducted early morning and late afternoon in this area while 
visitation and dingo activity is high. 
 
 
 
Faxed/emailed date:  09/01/14                                       Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingoes 
 
Date (of Interaction): 8/01/2014 
Location (of Interaction): Eli Camping Area 
Beachfront 

Time (of Interaction 24hrs): 08:00 
Reporting Officer/s details: 7028018 & 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 1-2 meters        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) 1-2 meters 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Jogger picked up by passing 

vehicle. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     4 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             2 
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Described as smaller  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (witness) 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments  
 

 
Detailed report of events:  
 
Dingo Ranger 7027330 received a phone call from (manager Cathedral Beach Resort) 
on the morning of 8/01/2014 notifying him that they had received a report from a camper that had 
intervened in a dingo interaction that morning. Ranger 7027330 contacted other rangers for assistance.  
 
Ranger 7026804 patrolled the Eli and Maheno camping areas for the campers that had reported the 
interaction but was unsuccessful at locating them. 
   
Ranger 7028018 contacted Cathedral Beach Resort who confirmed that the campers were setting up 
camp within the resort. Rangers 7028018 and 7028020 drove to the resort to interview the campers. 
 
At approx. 08:00 on the 8/01/2014 and his friend were driving north from Happy Valley along the 
beach, noticed a man (from a distance) jogging backwards trying to discourage two dingoes.  
 
The man (identity unknown) was jogging along the beach between Happy Valley and Eli Creek and was 
approached by two dingoes (described as small dingoes). The dingoes proceeded to follow closely 
behind the man as he was jogging. As the dingoes approached closer the man turned around to face 
them and tried to discourage them by throwing sand and yelling. The dingoes were not discouraged and 
proceeded to lunge at the man forcing him backwards into the ocean.  
 

and his friend saw the jogging man from a distance and headed towards him placing their vehicle 
between the dingoes and the man. The dingoes circled around the vehicle in an attempt to continue 
lunging at the man in the ocean. The man got into the rear seat of the vehicle.  
 
The two dingoes on the beach headed towards the foredunes where two other dingoes (described as 
larger dingoes) were sitting and watching. The four dingoes then headed into the Eli camping area. 
Moments later the dingoes were chased out of the camping area by a man swinging a shovel.  
 

and his friend dropped the jogger off at Happy Valley.  
 

and his friend relocated themselves from the Eli camping area to Cathedral Beach Resort as they 
were concerned for their safety and the safety of the dingoes if anything happened.  
 
 
Additional comments and notes: and his friend stated they did not look for ornotice any ear tags 
on the dingoes involved in the interaction when asked. The dingoes (larger) sitting on the foredunes 
were too far away to see if they were tagged. 
 
Dangerous dingoe signs have been installed in all camping areas from Winnam and Cathedral Beach 
Resort since mid 2013.  
 
A habituated pack are known to frequent the area between Poyungan Rocks and Eli Creek. Members of 
this pack have been involved in recently reported high risk behaviour. 
 
 
Action taken: RIC NRM contacted. Campers interviewed and a report generated and circulated. 
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 3 

 
Proposed further action: Continue regular ranger beach patrols and camper briefings. Increase the 
regular liaising with private enterprises and CTO's that are within or frequent the area. Implement a strict 
no jogging policy on Fraser Island in light of the increased interaction activity by dingeos towards joggers 
on the island.     
 
 
Faxed/emailed date:  9/01/2014                                 Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: D Dingo ID: GBW11m & 4 Untagged 
Dingoes 
 
Date (of Interaction): 9/01/2014 
Location (of Interaction): Eli Camping Area 
Beachfront 

Time (of Interaction 24hrs): 17:30 
Reporting Officer/s details: 7027904 & 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 1-2 meters        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) 1-2 meters 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Jogger was picked up by a 

passing vehicle 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     5 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile             4 
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Described as a red tag 
 
d. Which ears were tagged Left 
    Details: The larger dingo was tagged 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (jogger) 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The jogger did not follow 'dingo safe' messaging as she was running on her own and 
without any form of personal protection such as a stick. 
 
 
 
Detailed report of events:  
Rangers 7027904 and other were briefing campers within the Eli camping area on the 10/01/2014 when 
they were approached by who reported that she had been bailed up and herded into the 
ocean the previous evening. 
 
On the evening of the 9/01/2014 was running along the beach at approx. 17:30 just north of 
the Eli camping area, when she was approached by 5 dingoes. tried to deter the dingoes by 
throwing a piece of pumice stone at the larger dingo (described as having a red tag), but the dingo 
reacted aggressively 'charging at her' (lunging). The other 4 dingoes (described as smaller untagged 
dingoes) also started lunging at her and the pack forced into the ocean. The driver of a passing 
vehicle saw the interaction and drove their vehicle between the dingoes and allowing her to enter 
the vehicle and drive away safely.    
 
 
Additional comments and notes: There have recently been multiple interactions in the areas between 
Poyungan and Eli Creek involving an Orange tagged male dingo displaying high risk behaviour. This 
dingo has been previously identified as GBW11m. 
 
Ranger 7028020 stopped while she was jogging along the beach the morning of the 9/01/2014 
and briefed her on 'dingo safe' messaging, recommending that she did not run. The interaction 
happened the evening of the same day whilst she was jogging alone along the beach. 
 
Rangers were patrolling the beach within area around 17:30 but were unaware of jogging and the 
interaction. 
   
 
Action taken: RIC NRM contacted. Jogger interviewed and a report generated and circulated. 
 
 
Proposed further action: Continue regular ranger beach patrols and camper briefings. Increase the 
regular liaising with private enterprises and CTO's that are within or frequent the area. Implement a strict 
no jogging policy on Fraser Island in light of the increased interaction activity by dingoes towards joggers 
on the island. Consider closure of all camp areas between Poyungan and Eli.   
 
 
Faxed/emailed date:  11/01/2014                                    Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: D Dingo ID: GBW11m 
 
Date (of Interaction): 10/01/14 
Location (of Interaction): Eli Creek 

Time (of Interaction 24hrs): Approx 18:00 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Orange tag in left ear 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Campers were staying at Cathedral Beach Resort and had received and read all 
material given to them. 
 
Detailed report of events: is family and another family (4 adults and 3 children) were at Eli 
Creek when they noticed the approach of an adult (large) male dingo and two juvenile dingoes (smaller).  
The four adults were sitting on the bank of the creek watching the three children (aged 6,10 & 7) play in 
the water about 20m away. 
 
The male dingo trotted along the edge of the creek towards the group, stopping just in front of the adults 
(between the adults and the children).  The dingo looked at the adults on the bank, put his head down, 
turned and ran straight towards the children. 
 
As soon as the dingo started running threw his beer can at the dingo and ran towards it shouting.  
The other three adults in the group yelled at the children to stand up and not run.  Two more visitors, 
who were nearby, also ran towards the children. 
 
The dingo got within 5m of the children before changing direction and running up a steep incline on the 
far side of the creek. says that the dingo would take a few steps, stop, turn around and look at the 
group, before continuing up the hill, as they packed up and left. 
 

returned to Cathedral Beach resort and reported the incident to (manager). 
reported the incident to QPWS on 11/01/14. 
 
 
Additional comments and notes: and his family were at Eli Creek on the evening of 08/01/14 
about 17:30 when they noticed a male dingo and two juveniles in the area sniffing and digging in the 
sand but not paying any special attention to the people onsite. said that the dingoes involved in 
this incident looked to be the same dingoes they had seen previously however the behaviour of the male 
dingo was noticeably different - it did not stop to sniff or dig, and trotted at a steady pace until it stood 
between the adults and the children.  The group did not discourage the dingo as they thought he would 
continue doing his own thing as he had done on the previous occasion. 
 
The dingo shown in the photos (attached) is GBW11m, determined through comparison of photos, the 
location of the incident and previous high risk behaviour in the area. 
 
QPWS ranger 7028020 was patrolling between Poyungan and Eli on the afternoon of 10/01/14.  
GBW11m and 2 untagged juvenile male dingoes observed at the northern end of Eli CZ at 
approximately 17:30 (see previous Code C report).  Ranger observed dingoes until they moved out of 
the camping area and then continued patrolling south. 
 
Action taken: Incident reported to Cathedral Beach resort on 10/01/14.  Cathedral Beach Resort 
reported to QPWS on 11/01/14. 
 
Interview conducted with at Cathedral Beach resort, photos provided and sketch drawn by
(attached below) collected. 
 
Proposed further action: Continue dingo safe briefings and current increased monitoring and patrolling 
in this area and Eurong area while visitation and dingo activity is high.  Extra patrols will continue to be 
conducted by QPWS rangers between 05:30 and 07:00 and 16:30 and 18:00 in these areas. 
 
Due to the increase in high risk behaviour of the habituated dingoes between Poyungan Rocks and Eli 
Creek investigate the possibility of closing camping areas (Poyungan, Winnam Guluri & Eli) whilst high 
risk behaviour is occurring. Management to assess current risk and advise of further action to be taken. 
 
Faxed/emailed date:  11/01/14                                     Reporting Officers details:  7028020 
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 3 

Photos  

 

Photo 1. 
Description (who took 
photo/when):  Adult and 
two juveniles at Eli 
Creek 10/01/14 at 18:07 - 

 

 

Photo 2. 
Description (who took 
photo/when):  Orange 
tagged male (GBW11m) 
heading towards the 
children, Eli Creek 
10/01/14 at 18:14 -

 

 

Photo 3. 
Description (who took 
photo/when):  Orange 
tagged male running 
towards the children 
(who were just out of 
shot on the left hand 
side of the picture), Eli 
Creek 10/01/14 at 18:15 - 
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 4 

 

Photo 4. 
Description (who took 
photo/when):  
Comparison photo - 
GBW11m tag showing 
delamination - 27/08/13 
Yidney Rocks - QPWS 
 

 

Photo 5. 
Description (who 
took photo/when):  
Orange tagged male 
running towards the 
children (who were 
just out of shot on 
the left hand side of 
the picture), Eli 
Creek 10/01/14 at 
18:15 -

 

 

Direction GBW11m 
approached the group and 3 other 

adults sitting 
watching the children 

Direction dingo ran toward 
kids with chasing 
behind 

3 Children playing in the 
creek

2 other 
visitors who 
ran to help 

Eli Creek & Wooden 
Footbridge 
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 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingoes 
 
Date (of Interaction): 3/03/2014 
Location (of Interaction): Yidney Rocks 

Time (of Interaction 24hrs): 16:30 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) The dingoes didn’t leave 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             2 
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Yidney Rocks Owner 
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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 2 

Questionnaire:                  Specify visitor type   resort staff      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments was fishing alone. 
 
 
 
Detailed report of events: Ranger 7028018 was responding to a report of an interaction at Yidney 
Rocks on the night of the 3/03/2014, when he was approached by (Yidney Rocks 

who reported a separate interaction. 
 
At approx. 16:30 was fishing on the beach just south of Yidney Rocks when he 
noticed two dingoes approaching from the south. The two dingoes (described as smaller dingoes) 
approached within a couple of meters and started circling around him. described the dingoes 
behaviour as 'herding' him into the water. was up to his waist in the ocean but managed to move 
around the two dingoes and quickly walked towards Yidney rocks. The two dingoes followed
closely all the way to the Yidney rocks beach stairs. On several occasions made contact with the 
dingoes with his fishing rod when they approached too closely but he said this did not deter them at all. 
Once walked up onto the rocks he said he felt safer but the dingoes still loitered around on the 
beach.  
 
Approx. an hour later whilst cleaning a fish (at the Yidney Rocks accomodation) heard a noise 
behind him. One of the dingoes involved in the earlier interaction was sitting on the grass just meters 
away from him. yelled and waved his hands at the dingo but the dingo didn’t move. The dingo 
eventually left on its own accord.   
 
  
 
Additional comments and notes: No ear tags were noticed in the either of the dingoes ears during the 
interaction. The dingo pack frequenting between Poyungan and Eli Creek are highly habituated and 
showing increasing negative dingo/human interactions. The 'smaller' dingoes described are most 
likely juvenile members of this pack.  
 
 
Action taken: Interview conducted by NRM ranger and report generated and circulated. RIC notified. 
 
 
Proposed further action: Continue ranger patrols of the eastern beach and camp areas. Increase 
ranger briefings to visitors at Yidney Rocks and The Oaks accommodation during the Easter holidays.   
 
 
Faxed/emailed date:  5/03/2014                               Reporting Officers details:  7028018 
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 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 5/03/2014 
Location (of Interaction): Yidney Rocks 

Time (of Interaction 24hrs): 21:00 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             1 
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details: Too dark to see any ear tags. 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Yidney Rocks Apartments (Manager) 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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 2 

Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments has been a resident on Fraser Island for many years and actively promotes 
QPWS safe messaging to all Yidney Rocks visitors. 
 
 
 
Detailed report of events: At approx. 21:00 (Yidney Rocks manager) left her 
apartment at Yidney Rocks to walk across the lawn to (Yidney Rocks manager) 
apartment. noticed a dingo only a few meters away watching her. stopped, stood still and 
faced the dingo. The dingo ran at (described as charged), growled and dominance tested 
(described as bouncing from side to side). yelled for help (screamed) and a male guest staying at 
the Yideny Rocks apartments came running with his fishing rod in hand. The man ran at the dingo 
yelling and waving his fishing rod making contact with the dingo a number of times. The dingo promptly 
left the premises.  
 
 
Additional comments and notes: The man who chased the dingo away was involved in an interaction 
with a number of dingoes at Yidney Rocks on the 3/03/2014. 
 

voiced her concerns on the increasing number of dingo interactions around Yidney Rocks.
was also concerned that a number families with children and school groups are booked into the Yidney 
Rocks accommodation over the Easter Holidays. 
 

could not identify the individual dingo but mentioned that it was a juvenile dingo regularly seen 
loitering around the Yidney Rocks premises.  
 
There is a highly habituated dingo pack occupying the area between Poyungan Rocks and Eli Creek. Its 
likely that the dingo involved in this interaction is part of this pack.  
 
 
Action taken: Yidney Rocks contacted by NRM ranger. Interview over the phone and a report 
generated and circulated. Senior management notified. 
 
 
Proposed further action: Continue ranger patrols of the eastern beach and camp areas. Increase 
ranger visitor briefings at Yidney Rocks and The Oaks accommodation during the Easter holidays. 
Maintain the camp area closures between Poyungan and Eli Creek until after the Easter holidays.  
 
 
Faxed/emailed date:  7/03/2014                               Reporting Officers details:  7028018 
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 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: 1 Unidentified dingo 
 
Date (of Interaction): 17/03/2014 
Location (of Interaction): Approx. 2km north of 
Happy Valley 

Time (of Interaction 24hrs): 0900 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 3-4m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Dingo didn't leave -

got a lift back to her accommodation in a 
vehicle 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age: 30+ 
 
Name:       
Address:       
Phone #:       
Age:       
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 2 

Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments had read posters on dingo safety in the house they were staying at in Happy 
Valley. 
 
 
 
Detailed report of events: On Monday the 17.03.14 went for a jog along the beach 
north of Happy Valley on her own. had reached roughly 2km north of the township when she 
decided to return. When she turned around she noticed a dingo within 3-4 meters of her. began 
to walk back towards the township and the dingo continued to follow.  attempted to deter the 
dingo by 'shooing' - this had no effect as the dingo then snarl/growled at her, and then continued to 
follow close behind. continued to progress towards Happy Valley and successfully waved down 
a passing vehicle for a lift back.  
 
  
 
Additional comments and notes:  

was concerned about the interaction as she was unaware that dingoes would show this type of 
behaviour.  
 

had read posters in the house she was staying in about dingo safety and food security.  
Though felt that there was not enough information on how to appropriately act in such a situation.  
 
 
Action taken: Dingo ranger and senior ranger notified. Interview conducted and report generated and 
circulated. Dingo "safe messaging" advice supplied by rangers. 
 
 
Proposed further action: Continue ranger patrols of the eastern beach and camp areas. Increase 
ranger visitor briefings at Yidney Rocks, The Oaks accommodation and around Happy Valley during the 
Easter holidays. Maintain the camp area closures between Poyungan and Eli Creek until after the Easter 
holidays.  
 
 
Faxed/emailed date:  18.03.14                              Reporting Officers details:  7027118 
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 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: BWPi13f & BWR13m 
 
Date (of Interaction): 26/03/14 
Location (of Interaction): Eurong 

Time (of Interaction 24hrs): 1500 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) 1m 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) The people involved left in a 

vehicle. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1 1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWPi13f & BWR13m 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age: 24 
 
Name: 
Address:       
Phone #:       
Age:       
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 2 

Questionnaire:                  Specify visitor type   holliday letting guest      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Whilst travelling along the beach in front of the Eurong township 3 QPWS 
officers noticed Two ladies being circled by two dingoes. As the officers approached in their vehicle they 
were flagged down by the ladies. The officers positively identified the Two dingoes as they hung closely 
around the vehicle whilst the ladies entered. Ladies were taken back to their accommodation at second 
valley Eurong. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The two Ladies were staying in a holliday letting at Seccond valley 
Eurong. 
 
 
 
 
 
Action taken: Ladies involved interviewed and briefed regarding dingo safety by dingo ranger. Report 
generated and circulated. 
 
 
 
 
 
 
Proposed further action: Continue to patrol Eurong beach front regularly briefing walkers on dingo 
safety. Encourage lone walkers to walk in groups 
 
 
 
 
 
Faxed/emailed date:  28/03/2014                               Reporting Officers details:  
  7026936    
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: 1Female dingo with 
pinkish tag, 3 unidentified male dingoes 
 
Date (of Interaction): 01/04/14 
Location (of Interaction): Northern Orchid Beach 
Ramp 

Time (of Interaction 24hrs): 1700 
Reporting Officer/s details: 7027940 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) received a lift from 

Dingoes stayed in the area 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     4 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age 2 1       

 
c. Were the dingo(s) tagged Unknown 
    Details: Female had some pink on the tag, 
others unidentified  
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Waddy Lodge Care Taker  
Phone #:
Age:       
 
Name: 
Address: ?      
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: The care taker of waddy lodge reported that dingoes rounded up a 
man into the water at the northern orchid beach ramp Fraser Island on the 1/4/14 at 1700hrs. 3 
male dingoes and 1 female dingo were involved, on arrival the female was running in barking 
and snarling at the man in the water. had to intervene with his vehicle to distract the dingo and 
put the man in his car as he thought the situation was getting dangerous.  
 

stated that the Female dingo involved in the interaction had a pinkish coloured tag in the right ear. 
The 3 males that were nearby at the time were unable to be identified.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Rangers tried to locate within the Orchid Beach township but 
were unsuccessful.  
 
 
 
 
 
Action taken: Dingo ranger notified, preliminary report circulated, interaction report generated and 
circulated. 
 
 
 
 
 
 
 
 
Proposed further action: Increase patrolling in this area particularly late afternoon and early evening. 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Faxed/emailed date:  02.04.14                                              Reporting Officers details:  
     7027940 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: GGPi13f 
 
Date (of Interaction): 05/04/2014 
Location (of Interaction): Beach-1.1km nth Happy 
Valley 

Time (of Interaction 24hrs): 16:00 
Reporting Officer/s details: 7026480 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) The people left. 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: 1 tagged female GGPi13f, 1 unid 
juvenile 
 
d. Which ears were tagged Right  
    Details: GGPi13f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Brisbane.  
C/ Sailfish Resort Happy Valley 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments are long-term visitors the managers of Sailfish Resort.  
 
 
 
Detailed report of events: The party of 2 vehicles (3 adults and 2 children) passed 2 dingoes on the 
beach then pulled up at their usual fishing spot. stayed with her two girls (1 & 3) sitting and 
playing in the sand between the close vehicles while the others fished.  
 
One of the dingoes they passed came over to the vehicles to where and the 2 children were. It 
came within 2 metres. attempted to shoo it away on numerous occasions unsuccessfully. 
 

saw what was happening and returned from the water to assist, waving a pvc rod holder at the 
dingo in a attempt to move it on. The dingo was persisitent in trying to approach the children who were 
playing in the sand in close proximity (within hand reach) to their mother. 
 
The dingo began to display dominant/submissive testing (dancing around) towards The dingo 
eventually settled down and sat approximately 3-4 metres away from the group. kept the PVC 
pipe with her and use it to shoo the dingo as it persisted in attempting to come closer. 
 
A group of people with a 14-15yo teen approached the group then retreated back to Happy Valley when 
they saw how the dingo was behaving. A number of vehicles stopped for and enquired as to the 
safety of herself and the children. 
 
They were there for around 2 hours. The dingo stayed for the entire time, GGPI13f was still there when 
they left.  
 
 
 
Additional comments and notes: The dingo was not considered aggressive by the party, decribed as  
more of a nuisance. Party are long term visitors to the island aware of dingo-safe behaviour. They 
advised they have never encountered behaviour such as this previously. 
 
The groups were catching fish continuously and keeping them in the tray of one of the vehicles - this 
could have contributed to the dingo staying in the vicinity of this group. 
 
 
 
 
Action taken: Interaction reported from firsthand account. Report produced and forwarded. 
 
 
 
Proposed further action: Continue morning and afternoon patrols.  Continue briefings with campers 
and visitors.  Monitor behaviour of the known pack in this area.  Continue the closure of campzones 
between Poyungan Rocks & Eli Creek. 
 
 
 
Faxed/emailed date:  06/04/2014                               Reporting Officers details:  7026480 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: D Dingo ID: 'Red' tagged female and 
2 Unidentified 
 
Date (of Interaction): 05/04/2014 
Location (of Interaction): Chard Rocks 

Time (of Interaction 24hrs): 07:30 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 1m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age             2 

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: 1 tagged female, 2 unidentified 
 
d. Which ears were tagged Right  
    Details: Red tagged female 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Yidney Rocks 
Phone #: (Yidney Cabins) 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: were travelling north along the beach to go 
fishing when they noticed a male fishermen in the ocean at quite a depth with 3 dingoes actively 
swimming towards him.  The man was going under water as the waves were breaking over his head and 
the dingoes were getting knocked about by the breaking waves. 
As they got closer they noticed that one of the dingoes was a female with a 'red' tag but could not 
identify the other two. 

drove the car right up to the water’s edge and got out of the car, 
grabbed a couple of lengths of poly pipe (fishing rod holders) and waded into the surf to try and 
discourage the dingoes. 
The dingoes were chased off and by the men, yelling and actively chasing them, and moved south down 
the beach away from the group. 
The fisherman in the sea was able to make his way out, and though shaken, was not harmed. 

continued up the beach once they were sure the dingoes had left the area. 
 
 
 
Additional comments and notes: It's possible given the location, the partial tag description and the 
behaviour exhibited that these dingoes were part of a habituated pack that is known in this area. 
 
 
 
Action taken: Interview with conducted.  RIC notified.  Report compiled. 
 
 
 
Proposed further action: Continue morning and afternoon patrols.  Continue briefings with campers 
and visitors.  Monitor behaviour of the known pack in this area.  Continue the closure of campzones 
between Poyungan Rocks & Eli Creek. 
 
 
 
Faxed/emailed date:  06/04/2014                               Reporting Officers details:  7028020 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 33 of 231



 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 8 Apr 14 
Location (of Interaction): Burad CZ 

Time (of Interaction 24hrs): 2330 
Reporting Officer/s details: 7027130 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults             1 
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address Bilolela 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments rubbish and food stored in tent 
 
 
 
Detailed report of events: At 2330 campers were woken by a dingo tearing into their tent to gain 
access to rubbish that was left in a box inside the tent. The dingo grabbed the rubbish and was chased 
away by the campers. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: No ID was gained. Campers were briefed about food and rubbish 
security. 
 
 
 
 
 
Action taken: Campers interviewed and briefed. RIC Nth informed. Report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Brief and monitor area. 
 
 
 
 
 
Faxed/emailed date:  11Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: BWR13m 
 
Date (of Interaction): 11/04/2014 
Location (of Interaction): OTR CZ Beachfront 

Time (of Interaction 24hrs): 12:00-12:25
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 2m-10m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWR13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Croydon, Melbourne 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 37 of 231



 2

Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Whilst walking along the beach, and an off duty QPWS ranger 
suddenly noticed BWR13m appear from the dunes and run straight towards them.  Both walkers 
continued to walk while keeping an eye on the dingo, which proceeded to follow them at a distance of 
between 2m & 10m. 
The walkers stopped to see if the dingo would continue past them, however it got to within 2m and 
started displaying dominance testing behaviour (jumping from side to side, huffing and snorting, baring 
teeth, etc).  At this point the QPWS ranger yelled at the dingo, clapped their hands and waved a stick 
towards it.  The dingo backed off a few metres and stood watching. 
The walkers continued on, with the dingo again following closely behind.  They stopped a couple of other 
times however the dingo would not continue on past them - stopping within 5m each time.  When sand 
was kicked in its direction it would back off to around 10m before moving back in. 
After about 20mins the walkers stopped again at the water’s edge and the dingo continued on past 
them.  The walkers let the dingo get about 50m in front of the before continuing to walk south towards 
Eurong.  The dingo headed up into OTR CZ of its own accord after a few minutes.  The dingo did not re-
appear. 
 
 
 
Additional comments and notes: this dingo had been involved in a Code C approx. 1hr prior. 
 
 
 
Action taken: Photos obtained, report compiled and circulated. 
 
 
 
Proposed further action: Continue patrols and briefings in this area, including mornings and 
afternoons.  Monitor the behaviour of this habituated individual.  Consider closing One Tree Rocks & 
Wongai CZ if behaviour continues/escalates. 
 
 
 
Faxed/emailed date:  19/04/2014                               Reporting Officers details:  7028020 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

Photo 1.
Description (who took 
photo/when):  BWR13m,

11.04.14 
 

 

Photo 2.
Description (who took 
photo/when):  BWR1m,

11.04.14 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13M 
 
Date (of Interaction): 11Apr14 
Location (of Interaction): Cathedral Beach 
Beachfront 

Time (of Interaction 24hrs): 1145
Reporting Officer/s details: 7028576 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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 2

Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Single juvenile male sighted loitering at Cathedrals beachfront. The animal 
approached the QG and attemted to solicite food. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This animal is habituated however showing no aggression at this 
stage. 
 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, continue briefing program. 
 
 
 
 
 
Faxed/emailed date:  23Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: GGPi13f 
 
Date (of Interaction): 19/04/2014 
Location (of Interaction): Yidney Accommodation 

Time (of Interaction 24hrs): Approx. 15:00
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) A vehicle drove the mother 

and teenage girls to safety. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: At approx. 15:00 on the 19 April, two teenage girls were swimming in the 
surf opposite Yidney Rocks accommodation. The mother of the girls was sitting at the accommodation 
watching them when she noticed a dingo approaching. The dingo saw the girls and started running 
towards them. The mother quickly ran down to the beach to try and deter the dingo by screaming, 
yelling, clapping her hands and throwing sand but the dingo wasn’t deterred and wouldn’t leave. The 
mother and the two girls retreated into the surf to get away from the approaching animal but the dingo 
followed them into the surf.  
 
A passing vehicle stopped and asked if they were ok, which they promptly replied that they weren’t. The 
driver of the vehicle tried on numerous occasions to drive in between the ladies and the dingo but the 
dingo kept circling the car to get to them. The driver of the vehicle drove into the surf to retrieve the three 
ladies and drive them to safety.  
 
 
Additional comments and notes: The identification of the dingo was confirmed by the mother and two 
teenage girls as GGPi13f as the same dingo had been harassing them for days around the Yidney 
Beach accommodation. Whilst interviewing the mother GGPi13f was trying to get into their car only 
meters away. The dingoes’ id was confirmed by the mother and the interviewing ranger.  
 
 
Action taken: Interview conducted and report generated and circulated.  
 
 
Proposed further action: Continue camp briefings. Continue early morning and afternoon ranger 
patrols for compliance, community liaising, risk mitigation and monitoring purposes during the busy 
Easter holiday period. 
 
 
Faxed/emailed date:  20/04/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo(es) 
 
Date (of Interaction): 18-19/4/2014 
Location (of Interaction): Wongai Camping Area 

Time (of Interaction 24hrs): Overnight 
Reporting Officer/s details: 7027904 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Tent 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults               
Sub adults               
Juvenile               
Unknown Age         1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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 2

Questionnaire:                  Specify visitor type   camper     

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 

 
Detailed report of events: Sometime during the night on the 18th and 19th April, two children in a canvas 
tent with their parents thought they heard scratching on the tent. The parents ignored the children and 
said it was nothing. On 21/4/14, ranger 7027904 I was shown the rip marks that were later found. 
 
 
Additional comments and notes: The dingoes are most likely part of the habituated Eurong pack. 
 
 
Action taken: Interview conducted and a report generated and circulated. RIC NRM notified. 
 
 
Proposed further action: Continue camp briefings. Continue early morning and afternoon ranger 
patrols for compliance, community liaising, risk mitigation and monitoring purposes during the busy 
Easter holiday period. 
 
 
Faxed/emailed date:  23/04/2014                               Reporting Officers details:  7027904 
 
 
 
Photos  
. 

 

Photo 1. 
Description (who took 
photo/when):  
 
Rips in tent (7027904) 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingoes 
 
Date (of Interaction): 19/04/2014 
Location (of Interaction): Wongai Camping Area 

Time (of Interaction 24hrs): Approx. 22:00
Reporting Officer/s details: 7028641 & 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             2 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 

 
Detailed report of events: At approx. 22:00 on the 19th April, and his family (partner & 
four children) were woken to sounds of two dingoes inside their tent. quickly sat up and made a 
noise to try and deter the animals. One of the dingoes exited out the hole they had ripped through the 
side of the tent. The other dingo moved into the section of the tent where his partner and four young 
children were sleeping. As there was no exit in this section of the tent the dingo became agitated and 
ran at the wall of the tent, tearing another hole and exiting.   
 
 
Additional comments and notes: The two dingoes weren't identified as it was too dark to see any 
identifying features (ie. tags). The two dingoes involved in the interaction are most likely part of the 
habituated Eurong pack.  
 
 
Action taken: Interview conducted and a report generated and circulated. RIC notified. 
 
 
Proposed further action: Continue camp briefings. Continue early morning and afternoon ranger 
patrols for compliance, community liaising, risk mitigation and monitoring purposes during the busy 
Easter holiday period. 
 
 
Faxed/emailed date:  20/04/2014                               Reporting Officers details:  7028641 & 
7028018 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: GGPi13f 
 
Date (of Interaction): 19 April 2014 
Location (of Interaction): Beachfront Happy 
Valley 

Time (of Interaction 24hrs): 1710hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Vehicle intervened by driving 

into the ocean, allowing girls to get into car 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f (confirmed by ranger during 
Code C interaction with local resident 10 mins 
later) 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Confirmed identity 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Father of girls -
Address: Regular visitor to island 
Phone #:
Age: Two 14 year old girls involved 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments was fishing approximately 200-300m away at the time. He was confident that 
both girls are aware of dingo safe messages as they are regular visitors. 
 
 
 

Detailed report of events: Initial report of Code D interaction was provided by local Happy 
Valley resident who was involved in a Code C interaction slightly north of Happy 
Valley at 1720hrs (separate incident report generated). At the time of interviewing (who 
was worming with a fish offal bag), GGPi13f was persistently within 1m of him, and 
identified GGPi13f as having been involved in "chasing two girls" approximately ten minutes 
earlier. We continued our patrol north to Eli Creek and on our return past Happy Valley we were 
flagged down by a fisherman who identified himself as the father of the two girls who had been 
involved in the interaction. had also mentioned this interaction to QPS Sergeant 

who asked to identify tag colours - which he did as "green and pink tagged 
female". 
The father, stated that the two girls (both 14) had been about to collect pippies with a 
bucket approximately 200-300m north of where he was fishing (which would put them near the 
northern boundary of the 40km zone in front of Happy Valley). The girls bucket was empty at the 
time of the interaction, which began when they noticed a dingo running at them at pace. The girls 
backed into the ocean but the dingo continued towards them. A few vehicles were reported to 
have tried to intervene by placing themselves between the girls and the dingo, but it persisted in 
moving around the vehicles. At one stage the girls were waist deep in the ocean. The interaction 
concluded with an unidentified Toyota Prado driving into the ocean and allowing the girls to get 
inside and they were then dropped into Happy Valley township.  

 
 
Additional comments and notes: GGPi13f is highly habituated, not wary of adults or rangers and has 
been involved previously in at least one Code D interaction and numerous Code Cs. 
 
 
 
Action taken: Reported to NRM staff member 7028020 who passed information along to 7026466 
1748hrs. 
 
 
 
 
 
Proposed further action: Monitor behaviour closely, especially with early morning/late afternoon 
patrols. Continue opportunistic beach briefings in known territory. 
 
 
 
 
 
Faxed/emailed date:  20 April 2014                               Reporting Officers details:  7026804
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 21/04/2014 
Location (of Interaction): Wongai Camping Area 

Time (of Interaction 24hrs): Approx. 0315 
Reporting Officer/s details: 7027904 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Tent 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Clapped hands & screamed 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults               
Sub adults               
Juvenile               
Unknown Age         1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Brisbane 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper     

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 

 
Detailed report of events: At approx. 0315 on the 21st April, was woken to sounds of a dingo 
ripping into her tent. screamed, yelled and clapped her hands to scare the animal. The dingo 
was scared off and did not return. 
 
 
Additional comments and notes: The dingo ripped through the fly of the tent only but was trying to get 
into her tent. There was a bag of toiletries in her tent which may have attracted the dingo. Numerous 
other tent ripping’s occurred in the area even when there was no food or other obvious attractive items 
inside. 
 
 
 
Action taken: Interview conducted and a report generated and circulated. RIC NRM notified. 
 
 
Proposed further action: Continue camp briefings. Continue early morning and afternoon ranger 
patrols for compliance, community liaising, risk mitigation and monitoring purposes during the busy 
Easter holiday period. 
 
 
Faxed/emailed date:  22/04/2014                               Reporting Officers details:  7027904 
 
 
 
Photos  
. 

 

Photo 1. 
Description (who took 
photo/when): Rip in tent 
(7027904) 
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Dingo Interaction Report Form Insert Code: D Dingo ID: BWPi13f 
 
Date (of Interaction): 22/04/2014 
Location (of Interaction): Eurong Beachfront 

Time (of Interaction 24hrs): 0815
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) The dingo was directed away 

by a vehicle and bus. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWPi13f 
 
d. Which ears were tagged Right  
    Details: BWPi13f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: To be confirmed 
Address:       
Phone #:       
Age:       
 
Name: (Kingfisher ) 
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits Yes 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Approx. 08:15 on 22nd of April, ranger 7028018 (whilst patrolling the beach) 
noticed a dingo (BWPi13f) loitering around fishermen and walkers. The dingo was chasing birds, running 
into the ocean and around people on the beach.   
 
The dingo noticed a group of walkers (three ladies and a child) and started running towards them. When 
ranger 7028018 was within close proximity to the walkers, BWPi13f was circling and nipping at their 
stick. The walkers were actively trying to deter BWPi13f but she was reacting by approaching closer and 
nipping their stick. Ranger 7028018 drove his vehicle between the dingo and the walkers and asked 
them to please walk towards the fenced Eurong township. BWPi13f repeatedly tried to circle around the 
car to get to the walkers. A Palace tour leader saw the interaction, drove up and asked if we needed 
assistance. The ranger responded "yes" but the tour operator mustn’t have heard and drove off. 
 
A Kingfisher bus driver exiting the Eurong township also saw the interaction and drove the bus between 
the dingo and the walkers. BWPi13f was behaving agitated and aggressive (mouthing and cough 
growling) and started circling the bus and the ranger vehicle. BWPi13f then tried to run at the walkers 
but was stopped by the bus driving between her and the walkers. The bus driver opened his door and 
moved the walkers into the Eurong fenced township.  
 
 
Additional comments and notes: One of the walkers was stopped (whilst walking alone along the 
beach) and briefed by ranger 7028018 earlier that morning (approx. 07:15). The ranger recommended 
that she doesn’t walk alone and walk with a stick. She responded that she hadn’t seen any dingoes 
(BWPi13f was only 50 meters away trying to solicit food off fishermen) and that she has German 
Shepherds. The lady walked up the beach a retrieved a stick from the dunes.  
 
 
Action taken: Interviews taken and a report generated and circulated. RIC notified. 
 
 
Proposed further action: Continue early morning and afternoon ranger patrols between Dilli Village 
and Eli Creek during the busy Easter/ANZAC holiday period. Continue ranger visitor and camper 
briefings.   
 
 
Faxed/emailed date:  22/04/2014                               Reporting Officers details:  7028018 
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 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: 2 Unidentified 
 
Date (of Interaction): 29/04/2014 
Location (of Interaction): Eurong Beachfront 

Time (of Interaction 24hrs): Between 2pm & 3pm 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When CTO bus pulled over 

and woman got into a car 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Eurong Resort Employee 
Phone #:       
Age:       
 
Name: 
Address: Poyungan Rocks 
Phone #:
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 57 of 231



 2 

Questionnaire:                  Specify visitor type   resort staff      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments was walking alone without a stick. 
 
 
 
Detailed report of events: Rangers 7026804 and 7028020 were informed that 2 Poyungan Rocks 
residents had intervened in an interaction on 29/4/14 late on 30/4/14. 
 
Contact was made with from Poyungan rocks on 1/5/14 to gain some information relating to 
the interaction.  They stated that they had driven out of Eurong Second Valley and noticed that the 
beach was completely empty except for a woman up to her waist in the water and 2 dingoes in the area.  
As they got closer they observed that a male dingo was in the ocean up to his neck (was almost 
swimming) trying to get to the woman in the ocean and a female dingo was lying on beach at the water’s 
edge. pulled up at the water’s edge and attempted to scare the male dingo away by 
throwing pumice at it.  The dingo would move away a short distance before returning - this happened 
several times. 
A Discovery tour bus pulled up to see if they could help - putting their bus between and the 
dingoes.  At this stage the dingoes stayed on the far side of the bus, allowing the woman to exit the 
water and get in the car with and be driven back to Eurong. were able to 
ascertain that the woman was a Eurong Resort employee, and dropped her off at the shop. 
 
Ranger 7028020 then interviewed the employee involved in the incident at Eurong Resort. stated 
that she has been walking along the beach on her own when she noticed two dingoes coming towards 
her.  One of the dingoes ran straight towards her and she attempted to make it leave by raising her arms 
above her head and trying to make herself bigger.  When this did not work she chose to walk into the 
ocean, however one of the dingoes followed her into the ocean and would not leave.  The second dingo 
stayed close and sat at the edge of the water watching. 

then said that some neighbours had then stopped to help her and had dropped her back inside 
the fence. 
 
 
 
Additional comments and notes: were not able to provide any tag colours.  They also 
stated that the woman was not injured but appeared shaken up. 

was not able to say whether the dingoes were male or female or had any tags.  She said they 
appeared 'fattish'. 
 
 
 
Action taken: Interviewed and Briefed on dingo safe behaviour.  Report 
completed and circulated.  RIC notified. 
 
 
 
Proposed further action: Continue patrols of this area, including mornings and afternoons.  Monitor 
behaviour of known habituated dingoes in this area.  Install new signage within resort area when 
available.  Investigate translation of dingo safe messaging into Japanese & Korean. 
 
 
 
Faxed/emailed date:  01/05/2014                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: D Dingo ID: unknown 
 
Date (of Interaction): 29/4/14 
Location (of Interaction): N end of Eugarie CZ 

Time (of Interaction 24hrs): 6-7am 
Reporting Officer/s details: 7027146 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Tugun QLD 4224 
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments and her partner indicated that they had received a dingo safety briefing from a 
Ranger on 28/4/14 (the day they arrived at Eugarie CZ).  
 
 
 
Detailed report of events: states that: 
* at some point between 6:00 and 7:00 am on 29/4/14 she was squatting down over a toilet hole that had 
been dug into the sand approximately 25 metres from their camping structures. 
* she noticed the dingo approaching rapidly from the north of where she was  
* she quickly stood up and noticed that her partner had also approached from the direction of their camp 
in an attempt to move between her and the dingo 
* the dingo approached to within a couple of metres of where she was located and she reports that it had 
its mouth open and teeth bared "looking like it might try to bite me". 
* she reports that the dingo did not make any attempt to bite her but did make a "half hearted" lunge 
toward her while her partner was trying to drive it away. 
 
* partner moved between her and the dingo very quickly after the dingo approached and was able 
to ward it off away from their camp. 
* and partner indicated that they have been extremely vigilant around their campsite in relation to 
keeping food and rubbish secured on the back of their (dual cab trayback) vehicle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Incident was reported late in the day on 1/5/14 

and partner stated that at various times during their stay they have observed a pack of 4 dingoes 
moving freely through the area in which they are camped.  

was unsure if the dingo that approached her was one of this pack. 
 
 
 
 
 
 
Action taken: Thanked and partner for bringing this incident to QPWS attention. 
Report completed and emailed as per distribution list 2/5/14. 
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 3 

 
 
 
 
 
 
Proposed further action: Refer to NRM 
 
 
 
 
 
Faxed/emailed date:  2/5/14                                              Reporting Officers details:  
7027146 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 22 May 14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 2030 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Had no food in tents; most had camped on Fraser prior. 
 
 
 
Detailed report of events: Campers had gone to bed; a short time later noise was heard in the camp. 
Two adult males got up to investigate; they saw a dingo in the camp and chased it away. On inspecting 
the camp a water container had been knocked over and the fly of a tent housing a lone female camper 
was torn. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: When setting up camp at approx. 1800 two unidentified dingoes 
were seen in the area and a bag was stolen from one of the tent, which was later recovered (Code C to 
follow). GGG13M was also seen in the area 23May14 outside his normal pack range. 
 
 
 
 
 
Action taken: Campers briefed, SR FI informed, Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor area, Patrol and brief 
 
 
 
 
 
Faxed/emailed date:  23/5/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unknown 
 
Date (of Interaction): 23/5/14 
Location (of Interaction): Orchid Beach 
Township, 1 Orchid Crt 

Time (of Interaction 24hrs): 2200 
Reporting Officer/s details: 7027816 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Lady went back inside house 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:
Phone 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments said that previous to the interaction, he had not cleaned fish or had anything 
about that would possible attract dingos to the area. 
 
 
 
Detailed report of events: Whilst traveling thru Orchid Beach township on the 25th May ranger 7027816 
was stopped by a local resident. He asked when 7027518 was back and was advised not for some time. 

expressed concern about the dingoes at present. He then detailed an interaction that had 
occurred several nights previous. went outside the front of their house 
late in the evening. As she was doing so a dingo approched to within five meters and growled / snarled 
at her. She then retreated back into the house. Their property is not fenced. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:  The next night they heard a pack of dingoes howling and fighting at 
approximatlety the same time, a short distance away (possibly in his neighbours back yard).  
 
 
 
 
 
Action taken: Interaction report, notified RIC NRM. 
 
 
 
 
 
 
 
 
Proposed further action: Continued monitoring of activity within Orchid Beach township. 
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Faxed/emailed date:  26/5/14                                              Reporting Officers details:  
7027816 
 
 

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 68 of 231



 4 

Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: 3 unidentified dingoes 
 
Date (of Interaction): 26/5/14 
Location (of Interaction): 400m south of Eurong 
Township 

Time (of Interaction 24hrs): 1730 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) After repeated attempts by 

car to intervene. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             3 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #
Age: 24 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments made an attempt to follow QPWS dingo safe messaging. When this did not deter 
the dingoes, he felt he would be safeset in the water. 
 
 
 
Detailed report of events: was Jogging north along the beach approximately 400m south of the 
Eurong township at 1730 on the 26/5/14. He first noticed 3 dingoes ahead of him standing 30m from the 
water. The dingoes began approaching so he attempted to deter them by standing tall and 
shouting at them.  
 
The dingoes then began to run towards so he thought he would be safest in the water. The dingoes 
followed him as deep as they could stand, so entered the water to his waist depth.  
 

stayed in the ocean at his waist depth while the Three dingoes stood in the water for approximately 
5 minutes. During this time he called 000 to report, he was "being attacked by dingoes". He noticed a car 
approaching and it attempted to take the dingoes focus from the him in the water. The dingoes began to 
run at and circle the car. then attempted to exit the water, before the dingoes would then turn their 
attention back to him and he would have to retreat back to waist depth.  
 
The occupants of the car shouted to that they would go to get some help. The car left in the 
water and went to the eurong resort to report that someone was "being attacked by dingoes". Two of the 
dingoes followed the car while one remained at the waters edge. remained in the water for 
approximately 5 minutes, until the car returned. When the car returned the remaining dingo left the 
scene entered the car and was returned to his camp.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: RIC NRM received a phone call from the Eurong resort at 1740, 
reporting that, someone was being attacked by dingoes. RIC NRM immediately called ranger 7026936, 
to investigate. 
 
As was entering the vehicle, a QPS police officer asked if he had been "attacked 
by dingoes", as a 000 call had been made. was able to confirm to that he made the 000 call. 
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Action taken: was returned to his campsite and interviewed. 
 
 
 
 
 
 
 
 
Proposed further action: Continue to brief lone walkers and joggers regarding dingo safety. Consider 
including warnings to visitors regarding dingo safety while walking or jogging on Fraser Island. 
 
 
 
 
 
Faxed/emailed date:                                      Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
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Description (who took 
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Dingo Interaction Report Form Insert Code: D Dingo ID: unidentified dingo 
 
Date (of Interaction): 28 May 2014 
Location (of Interaction): One Tree Rocks 
camping zone 

Time (of Interaction 24hrs): 0200hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) when disturbed 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             X 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Not described - too dark 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age: y.o. mother and y.o. son sleeping 
within 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Misinterpreted food security standards and expectations 
 
 
 
Detailed report of events: Initial report via email and also phone message at Dundubara 
From: QPWS  
Sent: Wednesday, 28 May 2014 10:36 AM 
To: Corro QPWS East SFC 
Subject: Urgent re Dingo's destroying tent on Fraser 
Importance: High 
 
Good Morning, 
 
I have just been notified from the Government Call Centre that a camper at One Tree Rocks has had 
Dingo’s get into the tent and destroy it.  Apparently no food was in the tent at the time, but given that the 
campers have a small child they want to report the issue and move campsites ASAP. 
 
The booking number is Starting 26/5 for 10 nights, 5 Adults and 1 Child. Car Rego is

Could someone please contact ASAP. 
 
If you need us to make a new booking for the customer in ParksQ please let me know. 
 
Regards, 
 
Fiona 
 
Phone contact made with at midday, Wednesday 28th of May. She advised that up to five 
dingoes had been problematic at their camp since their arrival on Monday 26th of May with persistent 
loitering and ripping holes in all four of their tents/camper trailers on Tuesday 27th of May (separate code 
C interaction reported will be generated); accessing food from plastic clip lock containers and canvas 
camp cupboard stored within the tents/trailers. On one of their camper trailers there was evidence in the 
form of scratch marks on the canvas and small holes suggesting that a dingo(es) had attempted to 
enter. At 0200hrs on Wednesday 28th of May, and her husband, mother y.o.) and son y.o.) 
were awoken by the noise of a dingo ripping the screen within their camper trailer in which they were 
sleeping. The dingo fled at the disturbance of the campers awaking and was thus unidentified, but it was 
evident that the dingo had pushed under the external flap doors (which were not fixed to a ground sheet) 
and then scratched a hole in the internal screen in an attempt to enter (the hole was within 300mm of the 
head of sleeping y.o. mother). group initially contacted 13 74 68 in an attempt to 
report the interaction and to get advice on alternate, 'safer' places to camp. 
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Additional comments and notes: claimed to have sighted the following tags on dingoes during 
the course of her stay in One Tree Rocks camping zone (may or may not have been involved in this 
interaction) - green tag in right ear (predominant dingo that would come in closest to camp); pink tag in 
left ear and blue tag in left ear. last visited 5 years ago and she commented that dingo behaviour 
was markedly poorer now. Interaction was also reported verbally to QPS who came into 
office to check whether we were aware of it. 
 
 
 
 
 
Action taken: Offered ability to relocate camp to Central Station campground (fenced); reported verbally 
to Eurong Dingo Ranger and NRM RIC on 28.05.2014. 
 
 
 
 
 
 
 
 
Proposed further action: Consider temporary closure of One Tree Rocks and Wongai camping zones 
to mitigate current dingo activity and reduce likelihood of interactions with humans. 
 
 
 
 
 
Faxed/emailed date:  29.05.2014                               Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Blue White Red 13m 
 
Date (of Interaction): 5/6/14 
Location (of Interaction): Eurong beachfront 

Time (of Interaction 24hrs): 1700 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) when threw a stick over 

the dingoes head. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Blue White Red 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Witness who intervened - (Nomads 
tag along leader) 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments Attempts to find family involved in interaction have been unsuccessful so far. 
 
 
 
Detailed report of events: Information derived from account given by Nomads tag along tour leader 

shortly after interaction occurred. At 1700 on 5/6/14, was walking out the beach bar access 
gate of the Eurong township when he noticed a dingo standing 2m from the gate. He said he clearly saw 
that the dingo was tagged in its left ear with the colours Blue White Red on the tag. 
 

continued walking down towards the water with his group whilst keeping an eye on the dingo they 
had seen at the gate. He also noticed that there was a family standing at the water’s edge with 2 young 
children approximately 5 and 6 years of age. said he saw the children begin to run around at the 
water’s edge and noticed the dingo running quickly from the gate towards them (approx. 80m away). 

described this as "the dingo Made a beeline for the kids". 
 

was approximately 50m from the children and began to run to intercept the dingo 3m before the 
children. said the parents didn't seem concerned about the dingo and the children continued to run 
around 5-6m from their parents. Whilst was keeping himself between the dingo and children, he 
was attempting to deter the dingo by yelling, waving his arms and slapping his thong on the sand.
was also urging the parents to go and get their children. This continued for a few minutes while 
members of tag along group came to assist him in deterring the dingo. said he got a stick 
about 20cm long off one of his group and threw it over the dingoes head, at which point it ran away. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: BWR13m is one of the 2013 born Eurong Juveniles who is known to 
be habituated and has previously been involved in 6 Code C, 2 Code D & 1 Code E interactions in the 
last 2 months. 
 

said that while he was deterring the dingo from the children, he saw that it was the same dingo that 
they he had observed moments before at the gate, Blue White Red tag in the left ear. 
 

said that he remained on the beach with his group until dark and observed the kids playing 5-10m 
from the parents at times. He did not see the dingo return. 
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Action taken: Report came to ranger 7026936 at 1740 from ranger 7026804. Contact was made with 

from Eurong resort at 1750, brief statement obtained. Contact was made with at 1800 who 
provided a detailed account of his version of the interaction. According to the Family involved was 
staying in Happy Valley, an attempt was made on the morning of the 6/6/14 to catch up with the family, 
to no avail. 
 
SR's notified morning of 6/6/14. Report generated and circulated 6/6. 
 
 
 
 
 
 
 
 
 
Proposed further action: Patrol area until dark to brief families, lone walkers/joggers and fishermen 
with regard to dingo safety and food security.  
 
 
 
 
 
Faxed/emailed date:  6/614                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
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photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: RBW13f 
 
Date (of Interaction): 05/06/2014 
Location (of Interaction): Cathedrals on Fraser 

Time (of Interaction 24hrs): During the day. 
Reporting Officer/s details: 7018930 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) unknown- video showed it 

move off. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: RBW13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Low socks and small tail tip consistent 
with RBW13f.  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Previous employee at Cathedrals on 
Fraser 
Phone #:       
Age: 26 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   resort staff      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments All resort staff receive regular Dingo breifings. 
 
 
 
Detailed report of events: Interaction sourced from Facebook. A resort staff member allegedly 
attempting to deter a dingo from shop area was dominace tested. The link to the video took 
is below. The footage and associated comments appeared on the and
face book pages. 
 
 

 
Additional comments and notes: The Cathedrals on Fraser staff are regularly briefed by QPWS 
rangers regarding appropriate behaviour around dingoes. The fence has recently been completed. 
These dngoes do not frequent this area anymore. Dundubara DR also verified dingo identification. 
 
Additional post inserted and interaction report resubmitted 
 
 
 
Action taken: Interaction reported.  
 
 
 
 
 
 
Proposed further action: Continue liaison with Cathedral Beach Resort staff, other resort staff and 
mangers regarding dingo safety and appropriate behaviour. 
 
 
 
 
 
Faxed/emailed date:  30 June 2014                               Reporting Officers details:  7018930 
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Photos  
 

Photo 1. 
Description Screen shot of 

facebook page with 
interaction details. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Further interaction details  
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Photo 2. 
Screen shot of remaining 
comments pertaining to the  
interaction on facebook 
page with interaction details. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

s.68(4)(c) Copyright infringement

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 85 of 231



 5

 

Screen shot of remaining 
comments pertaining to the  
interaction on facebook 
page with interaction details. 
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Dingo Interaction Report Form Insert Code: D Dingo ID: GGPu13m 
 
Date (of Interaction): 12 June 2014 
Location (of Interaction): Govi camping zone, 
approximately 100m from northern boundary 

Time (of Interaction 24hrs): 1400hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) continued to loiter on and off 

for three days 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPu13m (confirmed) 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:confirmed identity during Code C 
interaction observed by Rangers 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Booking #
Phone #:
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Possibly should have considered relocating camp given persistence of dingo 
 

 
Detailed report of events: Campers reported during an interview regarding a Code C interaction 
(submitted separately) that the same dingo (confirmed identity GGPu13m by Rangers) had been 
loitering around their camp for three days (often lying on the foredunes overlooking the camp) and at 
one stage when they attempted to discourage him from about 10 metres away he engaged as what they 
described as 'playful behaviour by dropping on to his front legs and bouncing around' (i.e. dominance 
test). GGPu13m continued to loiter on and off around their camp and when they were fishing on the 
beachfront immediately in front of their camp. 
 
 
 
 
 
Additional comments and notes: Separate Code C generated  
 
 
 
 
 
Action taken: Briefed regarding dingo safe messaging; reported verbally to RIC NRM 15June2014. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingo activity, consider risk mitigation options under FIDCRMS.
 
 
 
 
 
Faxed/emailed date:  16 June 2014                               Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified 
 
Date (of Interaction): 30/6/14 
Location (of Interaction): Between Cathedrals 
and Maheno - Beachfront edge of water 

Time (of Interaction 24hrs): 1430
Reporting Officer/s details: 7027816 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Boogie board swung at Dingo 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults       1       
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Described as smaller female animal 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Four children (two twelve years + two fourteen years), playing in the shore 
break on the beachfront. Two dingoes in approached along back of beach. Female dingo approached to 
within two meters of children, who ran backwards into the water, the dingo actively followed them. The 
dingo was actively deterred by the parents, who swung a boogie board at it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Report only received yesterday afternoon at Cathedral shop. 
7027816 saw photo of dingo taken by fourteen year old but was unable to identify it. Although described 
by parents as smaller female dingo, dingo looked to be of normal size with a lighter colouration from 
photo. 
 
 
 
 
 
Action taken: Notified RIC NRM, Notified NMU Dingo Ranger, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continued briefings and patrols 
 
 
 
 
 
Faxed/emailed date:  3/7/14                                              Reporting Officers details: 7027816
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Dingo Interaction Report Form Insert Code: D Dingo ID: Untagged 
 
Date (of Interaction): 25/06/2014 
Location (of Interaction): Z Force Track 

Time (of Interaction 24hrs): Late afternoon 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 2-3 meters        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) 2-3 meters 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (KBRV Manager) 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   commercial tour operator     

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The tour operator responded well by informing their tour participants on dingo safety  
 
 
 
Detailed report of events: (Kingfisher Bay Resort Manager) contacted QPWS 
Maryborough on the 26/06/2014 to report a dingo interaction. Ranger 7028018 contacted KBRV to 
conduct an interview and record the interaction details. 
 
Late in the afternoon on the 25/06/2014, a KBRV tour group was walking along the z force track when 
they were approached by a dingo. The dingo circled around them and bounced around on its front paws, 
with its tail up and mouthing the air. The tour leader cautioned the tour participants to stay close and 
stand still. After a few minutes the dingo left on its own accord. 
 
 
Additional comments and notes: A member of the tour group filmed the dingo circling them. The 
dingoes behaviour was described as 'playful'.  

KBRV manager) reported that a dingo (described as 'she' but the gender is unconfirmed) is 
regularly seen occupying the beach between McKenzies Jetty and Dundonga Creek and has interacted 
with a number of guests. 
  
Trail camera monitoring confirms that a juvenile dingo (gender unconfirmed) is regularly seen occupying 
the Kingfisher Bay resort beach front.  
 
 
Action taken: Reported to QPWS by KBRV management. RIC and dingo ranger notified. Interview 
conducted and a report generated and circulated. 
 
 
Proposed further action: Obtain the camera footage from KBRV to ascertain identification features. 
Continue monitoring the area and maintain regular contact with KBRV management. If the dingo persists 
loitering near/around visitor areas implement capture and tag procedures.  
 
 
Faxed/emailed date:  26/06/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 3/7/14 
Location (of Interaction): Wahba CZ 

Time (of Interaction 24hrs): 2130
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Canvas door 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Very tidy camp all food and rubbish packed away 
 
 
 
Detailed report of events: was woken at approx. 2130 by a scratching noise at the closed 
door of their camper trailer. She woke who yelled and moved toward the door as he opened the 
door he saw a dingo running away. On later inspection of the canvas door on the camper trailer a right 
angle tear was found in the door. 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Long term visitors were very surprised by this incident as they keep 
their camp spotless. The Oaks pack has been sighted in this area. 
 
 
 
 
 
Action taken: Interview conducted, Ric Nth informed, Duty officer informed, Report generated,  
 
 
 
 
 
 
 
 
Proposed further action: Continue patrol and briefing regime 
 
 
 
 
 
Faxed/emailed date:  2/7/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified “Dingo with red 
coloured tag in left ear” 
 
Date (of Interaction): 16 July 2014 
Location (of Interaction): Eli Creek toilet block 
vehicle access track 

Time (of Interaction 24hrs): 0600hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 
X  loitering at recognized visitor sites (people    
       nearby)      
X  stealing food or property (specify) ugg boots 
and work boots 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 
X  growling/snarling 
X  dominant/submissive testing 

  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       

X  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

E) Dangerous. 
  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 

X  other (specify) person moved off 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 1             

 
c. Were the dingo(s) tagged Yes 
    Details: Tag colour described as ‘red’; possibly 
consistent with delaminated back of tag of  
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:No other features described 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age: 50s 
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   contractor      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Yes – moved away safely 
 
 
 
Detailed report of events: Contractor reported an interaction with a dingo at Eli Creek – firstly, having 
had his ugg boots and a work boot stolen from near the toilet block. was then on his way down to 
the beach to make a phone call via the vehicle access track from the toilet block when he encountered a 
male dingo with a ‘red tag’ in its left ear who initially engaged in what described as ‘playful 
behaviour’ (i.e. dropped down onto haunches and bounced around) and then the dingo remained 
lowered, bared its teeth and growled at and was described as preventing him continuing along the 
track to the beach. returned safely to the toilet block, without the dingo following him. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: ‘Red’ tag description is consistent with GBW11m tag (back 
delaminated to red) – known resident male in the area. No photos taken. 
 
 
 
 
 
Action taken: Reported through line channels. Dangerous dingo signage already in place on site. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor area, continue patrols and briefings in local vicinity. Maintain 
temporary closure of Eli and Guluri CZ. 
 
 
 
 
 
Faxed/emailed date:  16July2014                               Reporting Officers details:  7026804 
 
 
  

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 97 of 231



 1

Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 17/04/2014 
Location (of Interaction): Burad Camping Area 

Time (of Interaction 24hrs): Approx. 2045 
Reporting Officer/s details: 7027904 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Tent 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)      

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Gayndah 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 

 
Detailed report of events: At the southern end of Burad camp zone at approx. 2045 on the 17th April 
after going to bed at about 19:30, nd his wife were disturbed by sounds of a dingo trying to enter 
the kitchen area of their dual compartment tent yelled "get out of it". The dingo was scared off and 
did not return. 
 
 
Additional comments and notes: They had only seen one dingo in the area the following day and they 
described it as a darker colour. The incident was only reported when and his wife saw rangers at 
Eli. 
 
 
Action taken: Interview conducted and a report generated and circulated. RIC NRM notified. 
 
 
Proposed further action: Continue camp briefings. Continue early morning and afternoon ranger 
patrols for compliance, community liaising, risk mitigation and monitoring purposes during the busy 
Easter holiday period. 
 
 
Faxed/emailed date:  23/04/2014                               Reporting Officers details:  7027904 
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Photos  
. 

Photo 1. 
Description (who took 
photo/when). 7027330,        
23 Apr 14 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Male Dingo 
 
Date (of Interaction): 27/07/14 
Location (of Interaction): Eli Creek  

Time (of Interaction 24hrs): 1030 
Reporting Officer/s details:  7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)   

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 1 1       

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: The male dingo had a tag in its left ear. 
The female had one in its right ear. No tag 
identifications were obtained  
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: Male dingo was relatively large and in 
good condition. 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Kingfisher Resort (bus driver) 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   tour participant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: On the 27/07/2014 at approx. 1030, a Kingfisher Bay Resort & Village 
(KBRV) bus tour, led by was visiting Eli Creek. had noted two dingoes (a male 
and female that were both tagged) sitting in the sand dunes just north of Eli Creek. A dutch family 
(parents and three young boys) who were part of the KBRV tour started walking along the creek towards 
the area where the dingoes were situated. The three young boys playing in the creek started running 
and the male dingo, noticing the children, became excited and started running quickly towards them. 

yelled at the parents to protect the boys. Several other visitors that were close by 
intervened (yelling, chasing and throwing cans at the dingo) between the dingo and the family. The male 
and female dingoes then left the area travelling north along the dunes.   
 
 
 
Additional comments and notes: stopped ranger 7027848 and reported the interaction. 
Ranger 7028018 also contacted via phone and confirmed that the dingoes were tagged but 
positive identification wasn’t obtained. 
 
Members of a habituated pack are regularly seen in this area. There have been regular reports of this 
pack being allegedly fed and encouraged. CTO operators have been asked to assist QPWS in ensuring 
dingo safe messages are conveyed to their tours and anyone they feel they can or need to approach to 
discuss with if behaving inappropriately towards dingoes. 
 
 
Action taken: Interaction reported and a report generated and circulated. SMU & NMU 2IC's notified  
 
 
Proposed further action: Continue regular ranger patrolling of the areas. Continue educational 
briefings to commercial tour operators and visitors on dingo safe behaviour.   
 
 
Faxed/emailed date:  27/07/14                                  Reporting Officers details:   7027848 
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Dingo Interaction Report Form Insert Code: D Dingo ID: BRG13m 
 
Date (of Interaction): 1/08/14 
Location (of Interaction): Eli Creek DUA 

Time (of Interaction 24hrs): 1515 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Dingo was yelled at and 

chased away which distracted it from the child. 
Though continued to loiter around the DUA. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: BRG13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (witness) KBRV bus driver 
Address:       
Phone #:       
Age:       
 
Name: (witness) Hummer tour driver 
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments According to witnesses parents of the young girl involved, packed up and left 
immediately after interaction. 
 
 
 
Detailed report of events: At 1525 on 01/08/14, ranger 7026936 arrived at the Eli creek DUA where he 
witnessed a male dingo tagged Blue Red Green (see photo below) loitering around visitors and was 
greeted by KBRV tour bus driver reported a dingo interaction that he had witnessed 10 
minutes prior, while his group were stopped at Eli ck, involving the male dingo that was still loitering 
around the DUA.   
 
BRG13m was witnessed by passing through visitors and their cars parked around the edge of Eli 
creek. There were a number of people that were taking photos of the dingo as it passed through.
said that there was a young girl about 4 years old, playing in the middle of Eli creek approximately 10m 
from her parents on the bank. also said that he saw the dingo stop and look at the little girl before 
running quickly at her into and through the creek. The dingo ran to within half a meter of the girl when it 
was scared off by several of the people that were photographing the dingo, who ran and yelled at it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: A second witness, Tour guide for Hummer tours, relayed the 
same interaction to ranger 7026936 and confirmed that it was the same dingo that was still loitering 
around the Eli creek DUA and also that this was the only dingo in the area around the time of the 
interaction. Eli creek has been patrolled regularly by rangers since 30/7/14 and BRG13m has been the 
only dingo that persistently loiters in this area. 
 
 
 
 
 
Action taken: Two witnesses interviewed. Notified RIC and SR MUST. Report generated and 
circulated. Regular (3 times a day) patrols carried out to Eli creek DUA. 
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 3 

 
 
 
 
Proposed further action: Educate families of the potential risk in this area to children. 
 
 
 
 
 
Faxed/emailed date:  2/8/14                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7026936 
10 minutes after 
interaction 

 Photo 2. 
Description (who took 
photo/when):   
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified 
 
Date (of Interaction): 11/08/2014 
Location (of Interaction): South of Eli Creek 

Time (of Interaction 24hrs): Approx. 18:00 
Reporting Officer/s details: 7028020, 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) when chased with fishing rod 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 107 of 231



 2 

Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Been coming for years 
 
 
 
Detailed report of events: While on patrol on 13/08/2014 rangers 7028020 & 7027330 were 
approached by who reported that he had been fishing at approx. 18:00 on 11 August south 
of Eli creek when he had an interaction with a dingo. 

was approaching his car when he noticed a dingo standing beside it, he yelled at it however it 
wasn’t deterred and proceeded to crouch down on his front legs. shone his torch is its eyes but the 
dingo did not move. wife was behind him with a fishing rod and took the fishing rod and 
waved at the dingo while his wife yelled and the dingo moved away about 20m, stood around for a 
couple of minutes and the continued along the beach. 
 
 
 
Additional comments and notes: also reported another Code D involving his son and grandson 
(Code D report completed and circulated). 
 
 
 
Action taken: Interview conducted, report completed and circulated. 
 
 
 
Proposed further action: Continue patrols, including extra patrols, between Poyungan & Eli Creek.  
Continue briefing visitors and fishermen.  Continue closure of campground between Poyungan & Eli 
Creek. 
 
 
 
Faxed/emailed date:  13/08/14                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: D Dingo ID: 3 Unidentified 
 
Date (of Interaction): 12/08/2014 
Location (of Interaction): Eli Ck  Beachfront 
around 40km/hr sign 

Time (of Interaction 24hrs): 16:30-16:45 
Reporting Officer/s details: 7028020, 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 1m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             3 

 
c. Were the dingo(s) tagged Yes 
    Details: No tag ID obtained 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:
Phone #:       
Age:       
 
Name:
Address:
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 109 of 231



 2 

Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Whilst in Happy Valley township rangers 7028020 & 7027330 were 
approached by who reported an incident from 12/08/14. 

reported that he had been fishing on the beach near the 40km/hr sign at Eli Creek around 16:30-
16:45 when he noticed thee dingoes about 100m north up the beach approaching another two 
fishermen. 
He observed one fishermen (later identified as the father) walk up to the car to get some bait and the 
other fisherman (later identified as the son) remained in the water fishing.  As the father returned to the 
water the three dingoes came straight over to him and followed him within 1m back to the water (he was 
walking quite fast) and then proceeded to flank him until he was in the water to his thighs.  The two 
fishermen were yelling and waving their hands around to deter the dingo without any luck so ran 
towards them and assisted in chasing the dingoes up into the dunes where they then continued north.  

told rangers that the incident had been reported to the dingo information hotline by the fishermen 
involved (report below). 

was unable to give any ID's on the dingoes but thinks that two of them were possibly male. 
 
 
 
Additional comments and notes: Report from Dingo Hotline:   
" ?, Happy Valley and his son  and grandson  were 
fishing last night around 5.30, 6pm south of Eli Creek (near 40k zone) and were bailed up by three 
dingoes with no provocation.  One dingo (leader of pack) had a pink and green disc in left ear.  Luckily 
someone came to their aid as they were having trouble fending off the three dingoes.  No-one was bitten 
but they said it was quite scary. 
The son had earlier chased a dingo out of the back of his ute and was a bit aggressive then. 
Grandson’s phone (not sure of his age) is ." 
Ranger called on 13/08/14 to confirm the details of the incident, no answer on phone and 
message left. 
 
 
 
Action taken: Report completed and forwarded.  Ranger called on 13/08/14 to confirm the 
details of the incident, no answer on phone and message left (report will be amended if contact with 

is made). 
 
 
 
Proposed further action: Continue patrols and monitoring, including extra patrols, between Poyungan 
& Eli Ck.  Continue briefings of visitors, campers and fishermen in this area.  Continue monitoring 
behaviour and movements of known dingoes in this area. 
 
 
 
Faxed/emailed date:  13/08/2014                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 16 Aug 14 
Location (of Interaction): Waddy Point 

Time (of Interaction 24hrs): 0715 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) seen loitering around area for 

some time 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Picked up a stick and was dominant back toward the animal 
 
 
 
Detailed report of events: was walking down from Waddy point Headland when she slipped over, 
as she was getting up she noticed a dingo down on the beach watching her. picked up a stick and 
continued walking north. The dingo approached her and she waved her stick and yelled at the dingo 
which retreated a short distance rolled on its back and vocalised. continued walking, the dingo 
approached again this time jumped around. At this point a car drove between and the dingo, the 
dingo lost interest and moved away. The dingo was seen in the area for some time after. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: is a long time visitor and had never had an interaction like this 
before and was confused by the behaviour. The behaviour was explained to as dominance 
submissive testing. The dingo did not display any aggression. No sex or identification was supplied.  
 
 
 
 
 
Action taken: Interview conducted, report generated, Ric Nth informed 
 
 
 
 
 
 
 
 
Proposed further action: Continue patrolling and briefing regime, monitor dingoes in area. 
 
 
 
 
 
Faxed/emailed date:  27/8/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Possible Green Tag 
 
Date (of Interaction): 20/08/14 
Location (of Interaction): Waddy Point 

Time (of Interaction 24hrs): 1700 
Reporting Officer/s details: 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 1mtr        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) 1mtr 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) had help from onlookers who 

chased the dingo away by getting between the 
people and the dingo with their vehicle. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Dark ridge along back 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Mt. Isa 
Phone #:
Age: Adult 
 
Name:
Address: Mt. Isa 
Phone #:
Age: Adult 
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Camper had been briefed previously by myself about dingo safety 
 
 
 
Detailed report of events: were camping at the Waddy Beach Front Campsite and went 
for a walk on the beach on Wednesday 20/08 at 5pm.  They came across a dingo near the beachfront 
entrance to the beach. The dingo prevented any forward movement by the couple through dominant 
behaviour (lunging, growling, and circling within 1m). became worried when the dingo persisted in 
this behaviour for 10 minutes, during which time tried to deter the dingo and protect his wife by 
yelling and waving. Another visitor, who had seen the interaction, intervened and drove their car 
between the couple and the dingo. The dingo then seemed to lose interest and moved off into the 
bushes. 
 
 
 
Additional comments and notes: described the dingo as having dark fur along its back and a 
green tag.  Photos attached below are from an interaction earlier in the day around the same area and 
show PuGR13m who matches the description given.  This animal was seen in the area during the day; 
however no positive identification can be made in this case. 
 
 
 
Action taken: Report generated and notified dingo ranger 
 
 
 
Proposed further action: Continued camper briefings, and advising campers of dingo activity in the 
area. 
 
 
Faxed/emailed date:  23/08/2014                                   Reporting Officers details:  7028773 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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 3 

Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description  
Photo of PuGR1m taken by

(camper) 20/08/14 just 
before a previous interaction 
(reported) 
 

 

Photo 2. 
Description 
Photo of PuGR1m taken by 

(camper) 20/08/14 just 
before a previous interaction 
(reported) 
 

 

Photo 3. 
Description 
Photo of PuGR1m taken by

camper) 20/08/14 just 
before a previous interaction 
(reported) 

 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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 1 

 
Dingo Interaction Report Form Insert Code: D Dingo ID: PuGR13m 
 
Date (of Interaction): 20/08/2014 
Location (of Interaction): Waddy Point 
Beachfront 

Time (of Interaction 24hrs): 1100 
Reporting Officer/s details: 7028796 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) <5mtr        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) <5mtr 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) other person witnessed 

incident and chased the animal with a stick 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green Tag 
 
d. Which ears were tagged Left 
    Details: PuGR13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:dark ridge down back, dark colouration 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Bli Bli, QLD 
Phone #
Age: 35 
 
Name:
Address: Bli Bli, QLD 
Phone #:
Age: 35 
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The campers obtained their permit online and didn't receive any brochures. They had 
limited knowledge of how to act when comfronted by a dingo.  
 
 
 
Detailed report of events: Husband and wife were playing with their children near the lagoon at Waddy 
Beachfront, when a dingo approached them at a trotting pace from the direction of the Binngih 
Sandblow. It approached within 5 metres of the family and was displaying dominance testing by proping 
on its back legs and prancing from side to side. Family became concerned and walked backwards into 
lagoon, however the dingo wasn't deterred by this and continued to persist with dominant behaviour and 
lay down in the shallows of the lagoon. An onlooker saw what was happening and came with a stick 
which he used to chase the dingo away. Dingo took off up the beach in a northerly direction and 
proceeded to chase shore birds. 
 
 
 
Additional comments and notes: Photos obtained from and an onlooker.  Dingo identified 
by a dingo ranger as PuGR13m from his tag. 
 
 
 
Action taken: Report generated and dingo ranger advised 
 
 
 
Proposed further action: Continue camper briefing and advise visitors on increased dingo activities 
 
 
 
Faxed/emailed date:  20/08/2014                                   Reporting Officers details:  7028796 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description Photo of PuGR1m 
taken by 20/08/14 
before interaction 
 
 

 

Photo 2. 
Description  
Photo of PuGR1m taken by 

20/08/14 before interaction 
 

 

Photo 3. 
Description (who took 
photo/when):  Photo taken by 
onlooker 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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 4 

 

Photo 4. 
Description (who took 
photo/when):  Photo taken by 
onlooker 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 27Aug14 
Location (of Interaction): Winnam CZ 

Time (of Interaction 24hrs): 2100
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Tent 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When couple started talking 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Camp was very clean and tidy no food availability. 
 
 
 
Detailed report of events: At approx. 2100 his partner and their baby were asleep in their tent 
when partner was woken by a tearing sound. Initially she thought a tree limb had come down 
and tore the tent. She woke explained what she had heard and got up to investigate. On 
inspection of the tent a 1m tear along the lower seam of the fly and claw marks were found.
looked around the area no dingo was sighted.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:  A very clean and tidy camp, the only thing that could think of 
is the bib from their baby that had some food spilt from her evening meal on it was in the tent.  
 
 
 
 
 
Action taken: Interview conducted, SR FI informed, Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animals in this area, continue patrolling and briefing regime 
 
 
 
 
 
Faxed/emailed date:  29/8/14                                              Reporting Officers details:  
7027330 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Possible Green Tag 
 
Date (of Interaction): 03/09/2014 
Location (of Interaction): Sth. Indian Head 

Time (of Interaction 24hrs): 1200 
Reporting Officer/s details: 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) <1mtr        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) other person witnessed 

incident and chased away with vehicle 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green Tag 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:dark ridge down back, dark colouration 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: South Grafton 
Phone #
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The fisherman couldn't believe how brazen the dingo was, even though he had ample 
warnings of dingo through signage.  
 
 
 
Detailed report of events: was fishing 1.5 km south of Indian Head at midday when a dingo 
approached him from the south. 
 
The dingo ran at him even though there were a group of fisherman in the immediate area.  
 
It stopped within a metre of him and began growling and bareing it’s teeth.  
 
It persisted with this dominant/aggressive behaviour for over a minute when a friend intervened and 
drove his vehicle in between the nd the dingo.  
 
This allowed to retreat to his vehicle and once he was in the car the dingo lost interest and 
proceeded north to Indian Head. 
 
 
 
Additional comments and notes: Photos were taken by and his friends - these will be emailed 
to ranger 7028773 and added to the report when received.  Once the photos are received identification 
of the dingo involved may be determined. 
Recent observations of a green tagged male around Waddy Point have shown a sub-adult dingo with a 
delaminted tag.  This animal has been identified as PuGR13m. 
 
 
 
Action taken: Report generated. Dingo ranger & duty officer advised.  Continued camper briefings and 
advised visitors on dingo issues within the area. 
 
 
Proposed further action: Continue patrols and briefings of visitors (campers and fishermen) in this 
area.  Observe and report any dingo behaviour in the area. 
 
 
 
Faxed/emailed date:  05/09/14                               Reporting Officers details:  7028773 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: possible green tag 
 
Date (of Interaction): 03/09/2014 
Location (of Interaction): Indian Head Beachfront 

Time (of Interaction 24hrs): 12.30 
Reporting Officer/s details: 7028796 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) <5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) <5m 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Animal remained in area, 

mother retreated with child to vehicle and 
drove away 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Dark ridge down back, general dark 
colouration 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (Witness) 
Address: South Grafton 
Phone #
Age:       
 
Name: (Witness) 
Address:       
Phone #:
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments Reported by onlookers 
 
 
 
Detailed report of events: Report was provided who had been involved in an earlier 
incident with the same animal and had closely observed the dingoes’ movements.  
 
The dingo had been discouraged from area of earlier incident and ran north along top of dunes 
approximately 200 metres.  
 
It then proceeded to sit on top of the dunes and watch a small child who was sitting on the sand in front 
of a vehicle which was occupied by its mother.  
 

noticed that when the mother’s attention was diverted, the dingo ran down the dunes towards the 
child.  
 
The mother reacted swiftly, picking up the child and retreating to the vehicle before the animal reached 
them. The dingo circled the vehicle several times before the vehicle drove away.  
 
 
Report of interaction by obtained over the phone on 05/09/14: 
When the group he was in stopped to fish at Indian Head a dingo with a green tag in its left ear 
approached the group displaying aggressive behaviour and had to be deterred by driving his 
vehicle between the animal and another group member (see separate interaction report). 
 
After the dingo had lost interest in the group saw the dingo fix its attention on a mother and child 
apporximately 200m north up the beach. 
 

watched the dingo through his binoculars as it travelled along the dunes and sat above the mother 
and child watching.  The child was outside the car and the mother was appro 20m away. 
 

observed the mother turn her back and as soon as she did the dingo ran straight down the dunes 
and towards the child. 
 
The mother got to the child first and both of them got into the car.  A nearvy fisherman chased the dingo 
away into the dunes. 
 
The dingo returned to the dunes and sat and watched the car, until about 20mins later the mother and 
child got out of the car again. 
 
The dingo sat and watched until the mothers attention was divereted again and once again ran straight 
out of the dunes at the child.  The mother again gathered up the child and returned to the vehicle.  The 
dingo was again chased away by a nearby fisheman. 
 
This occurred at least twice and maybe three times before the woman drove away. 
 

spoke to a guy at the Orchid Hotel to advise him of the incident and the behaviour of the dingo.  
also left a message on the Dingo hotline reporting the interactions. 

 
 
Additional comments and notes: Recent observations of a green tagged male around Waddy Point 
have shown a sub-adult dingo with a delaminated tag.  This animal has been identified as PuGR13m. 
If an identification in the earlier interaction is made this report will be amended. 
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Action taken: Report generated. Dingo ranger and duty officer advised. 
 
 
 
Proposed further action: Continue camper briefings and advise visitors on increased dingo activities.  
Observe and report any dingo behaviour in the area. 
 
 
 
Faxed/emailed date:  05/09/2014                               Reporting Officers details:  7028796 
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Dingo Interaction Report Form Insert Code: D Dingo ID: unknown 
 
Date (of Interaction): 07/09/14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 10:10am 
Reporting Officer/s details: 7027146 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) when vehicle driven at it 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults             1 
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Camper states the dingo did not appear 
to be young, it was an older animal. 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age: 64 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: * is staying with various family members in Wyuna CZ. 
* was fishing in knee deep water adjacent to their campsite at approximately 
10:10am today (07/09/14) 
* states that he saw a dingo (he was not aware there was a dingo nearby) running quickly toward 

from the foredune area near their camp. 
* The dingo entered the shallow water directly behind and maintained its position there even as 

tried to get it to move away. 
* was able to move out of the water somewhat but the dingo was attempting to keep him there 
according to what could see. description was that it "was rounding him up". 
* Several other campers staying a couple of hundred metres to the south of were sufficiently 
concerned about safety that they got into their vehicle and tried to drive between the dingo and 

* states that the dingo was not easily deterred away from even as the vehicle was being 
driven at it. 
* The dingo eventually moved off and was able to return to camp. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: * The group were asked to remain vigilant regarding the possible 
movement of this dingo around their immediate camp area -  they have several young children.  
* The group were asked to try and photograph this or any other dingoes that they see in the area during 
the course of the stay and provide them to Rangers. 
* The group were given a Dingo-safe briefing prior to being notified about the incident (ie. I briefed the 
members of their party that were not fishing and only received the information about the incident after I 
moved on to the next campsite (which was camp). 
* Nil other reports from nearby groups regarding any negative dingo encounters were reported to me 
during the time I was in this area. 
 
 
 
 
 
Action taken: Code D Interaction Report completed and emailed to distribution list 
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Proposed further action: Refer to NRM for action 
 
 
 
 
 
Faxed/emailed date:  07/09/14                                              Reporting Officers details:  
7027146 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unknown 
 
Date (of Interaction): 11.09.2014 
Location (of Interaction): South Waddy Beach 

Time (of Interaction 24hrs): 1430 
Reporting Officer/s details: 7027130 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Ran off to chase a seagull. 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Dark coat 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Beachmere 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events:  

was worming on south Waddy Beach  
-saw a dingo approach 
-The dingo watched and when moved to a new spot the dingo followed displaying aggressive 
behaviour - growling and bearing its teeth, crouching and bouncing from side to side for some time.  
-The dingo then ran after segulls, swam across the gutter and ran off.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report generated and circulated.  
 
 
 
 
 
 
 
 
Proposed further action: Brief camps in the area, continue to monitor dingo behaviour in  the area. 
 
 
 
 
 
Faxed/emailed date:  14.09.2014                               Reporting Officers details:  7027130 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: PuGR13m 
 
Date (of Interaction): 11.09.14 
Location (of Interaction): Champagne pools 
board walk 

Time (of Interaction 24hrs): 0720 
Reporting Officer/s details: 7027788 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green tag left ear - ID PuGR13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: QPWS Rangers 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events:  
-Rangers 7027788 & 7026254 saw a dingo on the rocks at champagne pools 
-The dingo began swimming in the pools before heading out of view below rock cliffs 
- Dingo walked up C.Pools steps before noticing both rangers 
- The dingo began to dominance test - biting nearby trees, aproaching closely to each ranger in turn 
- The dingo ran away when ranger 7026254 chased it off. 
- On return to the C.Pools southern carpark the same dingo was found with a pair of goggles that were 
previously hanging in a tree. The dingo ran off and dropped the goggles (which were then retrieved and 
taken away). 
 
 
 
 
 
Additional comments and notes: Video of interaction taken on phone, Photographs taken and filed. 
The tag of PuGR13m has totally delaminated to all green on both the button (inside) and spike 
(Outside). The dingo of this incident has been positively identified as PuGR13m. PuGR13m has 
displayed similar behaviour at Waddy Point during the past couple of weeks.    
 
 
 
 
 
Action taken: Dingo ranger notified, report compiled and circulated. Photographs viewed by Waddy 
point Dingo ranger, Identifying the dingo to be PuGR13m  
 
 
 
 
 
 
 
 
Proposed further action: Monitor this area - talk with tour operators with regards to dingo behaviour in 
the area.  
 
 
 
 
 
Faxed/emailed date:  14.09.14                               Reporting Officers details:  7027788 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description 
(who took 
photo/when):  
Taken by 
Ranger: 7027788 
C.pools 
boardwalk 
11.9.14  

 

Photo 2. 
Description 
(who took 
photo/when):  
Taken by 
Ranger: 7027788 
C.pools 
boardwalk 
11.9.14 
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Photo 3. 
Description 
(who took 
photo/when):  
Taken by 
Ranger: 7027788 
C.pools 
boardwalk 
11.9.14 
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Dingo Interaction Report Form Insert Code: D Dingo ID: BWR13m 
 
Date (of Interaction): 16Sept 2014
Location (of Interaction): Eastern Beach 100m 
north of Oaks township 

Time (of Interaction 24hrs): 7:30am 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Vehicle moved in to deter 

dingo 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:  BWR13m 
 
d. Which ears were tagged Left 
    Details: Low tag 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: Large male. Sock markings pictured 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not obtained 
Address:       
Phone #:       
Age:       
 
Witness- person reporting interaction. 
Name: 
Address: Tweed heads 
Phone #: 
Age: mature aged 
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments commented that the man with the pregnant partner stated he was a regular 
visitor to the island however it was his wife’s first visit. 
 
 
 
Detailed report of events: On or around 7:30am was travelling south in a convoy of two vehicles 
on the eastern beach and witnessed a dingo following an adult male carrying a stick. The dingo was 
about 20 feet away from the man and was increasing it's pace.  
 

stopped the vehicle near the man who walked at a quick pace to meet this caused the dingo 
to also quicken it's pace towards him. When the man got to vehicle the dingo veared off and went 
to the waters edge and laid down until it saw a couple in their late 20's walking along the water's edge a 
distace away. 
 
The dingo returned to the mid beach area and waited, watching the the couple walk. When the couple 
(still walking at the waters edge) got to ~35 metres away the dingo crounched down and ran directly 
towards the couple (video footage shown to ranger).  
 

beeped the car horn to warn the couple. The noise caused the dingo to temporarily halt its advance 
and man shielded the woman behind him. then drove his car between the dingo and the couple.  
 
Both vehicles were fully occupied so the the couple and the other male who was originally walking, 
walked as a group of three back to the Oaks residential area (driver of the second vehicle) 
gave the couple an old umbrella to use if required for protection agaist a possitble further dingo 
interaction. 
 
 
 
 
 
Additional comments and notes: Graham photographed the dingo involved shortly before the 
interaction occurred (see photos below). From these photographs rangers 7026936 & 7026466 were 
able to identify the dingo as BWR13m. BWR13m is a member of the Eurong pack. 
 
 
Action taken: Interaction reported and residential areas (Yidney Rocks and the Oaks) advised of dingo 
behaviour in this area. 
 
 
 
 
Proposed further action: Continue liaison with owners/managers of residential areas (Yidney Rocks 
and the Oaks) regarding dingo behaviour in this area. 
 
 
 
 
 
Faxed/emailed date:  16 Sept 2014                               Reporting Officers details:  7026466 
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Photos  
 

 

Photo 1.
Description (who took 
photo/when):  BWR13m 16/9/14 
- (witness) 

 

 

Photo 2.
Description (who took 
photo/when):  BWR13m 16/9/14 
- (witness) 
 

 

 

Photo 3.
Description (who took 
photo/when):  BWR13m 16/9/14 
- cropped picture for tag colour 
and placement. 
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Photo 1.
Description (who took 
photo/when):  BWR13m 16/9/14 
- (witness) 

 

 

Photo 2.
Description (who took 
photo/when):  BWR13m 16/9/14 
- (witness) 
 

Jan 2014 

Photo 3.
Description (who took 
photo/when):  BWR13m sock 
markings taken by QPWS. 
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Dingo Interaction Report Form Insert Code: Code D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 18/09/2014 
Location (of Interaction): Waddy Point 
Beachfront Camping area 

Time (of Interaction 24hrs): 10.30 
Reporting Officer/s details: 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) People entered fenced area -

dingo remained in the area outside the fence. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults             1 
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Unknown 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address Wonthaggi Vic, 
3995. 
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Have been camping on Fraser on a regular basis and are aware of the dingo safety 
message. 
 
 
 
Detailed report of events: and her daughter were walking from the Waddy beachfront camping 
area to the Waddy Top Campground when they encountered a dingo within two meters of them. The 
dingo began growling at and daughter (12yrs old). This startled the daughter making her run up 
the stairs. had a kite with her and used it as a deterrant as she walked up the stairs into the 
fenced campsite. remained calm never looking at the dingo as she was too scared. 
commented that whilst the dingo didn't follow she could still hear it growling as she followed the track up 
to the camping area.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: : Report generated, dingo ranger notified. 
 
 
 
Proposed further action:      
 
 
 
Faxed/emailed date:  14/10/2014                               Reporting Officers details:  7028773 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Red Tag Male & 
Unknown Untagged 
 
Date (of Interaction): 19/09/2014 
Location (of Interaction): Lake Garawongera 

Time (of Interaction 24hrs): 10:00 
Reporting Officer/s details: 7028796 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans   

present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people          
nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) <2m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) <2m 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or       

unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When threatened with a stick 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1 1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Red 
 
d. Which ears were tagged Left 
    Details: Other dingo untagged 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:light colouration 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Nerang, QLD, 4211 
Phone #:
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments They followed the safety procedures and were glad that they read the pamphlets 
about dingo safety. 
 
 
 
Detailed report of events:  
 
Husband and wife with their two small children went for a walk to look at Lake Garawongera and 
encountered two sub-adult dingoes coming down the path towards them. 
 
As the dingoes approached, the dingoes split up and came at the family from opposite sides.  
 
The dingoes pushed them into a tight group and proceeded to lunge and circle, coming within 2 metres 
of the family.  
 
The family followed safe dingo procedures and stood back to back with the children in between the 
adults.  
 
The father tried to discourage the dingoes by yelling, however the animals weren’t deterred and 
persisted to circle and lunge for what they estimated to be 5-10 minutes.  
 
It wasn’t until the father was able to pick up a stick and swing at the dingoes, that they were able to 
slowly make their way back to the vehicle.  
 
Once inside the vehicle the dingoes continued to circle until the family drove away.  
 
 
 
Additional comments and notes: This interaction was also reported via the Dingo.Ranger e-mail 
address. 
Photos were obtained from the family, and are attached below.  Although no identification is possible 
from the photos, BWR13m is known to currently be frequenting this area and has a red button and spike 
which can be identified as a red tag.  BWR13m has recently been involved in a Code D interaction at 
The Oaks beachfront. 
 
 
 
Action taken: Report generated and dingo ranger advised.  RIC NRM & SR MUST notified. 
 
 
 
Proposed further action: Continue camper briefing and advise visitors on increased dingo activities.  
Monitor and record behaviour of known dingoes in this area. 
 
 
 
Faxed/emailed date:  20/09/2014                               Reporting Officers details:  7028796 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  Photo taken by 

at Lake 
Garawongera, 19/09/14. 
Red tagged male and untagged 
female sub-adults. 

 

Photo 2. 
Description (who took 
photo/when):  Photo taken by 

at Lake 
Garawongera, 19/09/14. 
Untagged female sub-adult. 
 

 

Photo 3. 
Description (who took 
photo/when):  Photo taken by 

at Lake 
Garawongera, 19/09/14. 
Untagged female sub-adult. 
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Photo 4. 
Description (who took 
photo/when):  Photo taken by 

at Lake 
Garawongera, 19/09/14. 
Red tagged male and untagged 
female sub-adults. 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 22 Sep 14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 1500 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) 5M 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Reported the interaction 
 
 
 
Detailed report of events: and another camper climbed up the ridge line behind the northern end 
of Wyuna CZ to get phone coverage. While up there they saw a dingo circle around two boys carrying 
boogy boards to the surf. The dingo followed the boys into the sea up to its chest. The dingo then lost 
interest in the boys and started chasing birds north. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Due to distance from the interaction he was unable to describe 
the actions of the dingo in any detail. PuGR13M has been sighted in the area and this is consistent with 
this animal’s behaviour. 
 
 
 
 
 
Action taken: Interview conducted, Ric NMU and SR FI informed, report generated, animal monitored, 
camps in area briefed. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, continue patrolling and briefing regime. 
 
 
 
 
 
Faxed/emailed date:  27/9/14                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):  7026804 during 
interaction 
 

 Photo 2. 
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: D Dingo ID: PuGR13M 
 
Date (of Interaction): 23Sep14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 0800 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green tag 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Long term visitor 
 
 
 
Detailed report of events: was walking along the beach at the south end of Wyuna CZ when he 
saw a seven year old boy heading down the beach to his father who was fishing. then noticed a 
dingo heading down the dune toward the boy, clapped his hands and yelled at the dingo which 
changed direction and moved away. continued walking south, a short time later he noticed the 
same dingo walking along the dune following him south. At this point picked up a stick, the dingo 
approached and crouched down, growled and bared its teeth. chased the dingo away yelling at it 
and waving the stick, the dingo ran off back up into the dune. The dingo was described as a male dingo 
with a green tag in its left ear. 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The description is consistent with PuGR13M who has been seen in 
the area. After taking statement PuGR13M was seen by 7027330 approaching his camp and 
was identified by one of the other campers as the dingo involved in the interaction.   
 
 
 
 
 
Action taken: Interview conducted,Ric NMU informed, SR FI informed, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingoes in the area, continue patrolling and briefing regime 
 
 
 
 
 
Faxed/emailed date:  26/9/14                                    Reporting Officers details:  
7027330      
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7027330 taken post 
interview in Wyuna CZ 
 

 Photo 2. 
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: D Dingo ID: 2 X Unidentified 
Dingoes 
 
Date (of Interaction): 24/09/2014 
Location (of Interaction): Winnam CZ beach front 

Time (of Interaction 24hrs): 1600 
Reporting Officer/s details: 7028796 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) <2m 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

E) Dangerous. 
  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When grandparents 

intervened 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             2 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Grandparents should have been closer to children in order to supervise properly 
 
 
 
Detailed report of events: 2 girls aged 9 & 13 were playing 20m from their parents on the beach in 
front of Winnam CZ at 1600 on the 24/9/14. They noticed Two dingoes approaching from 20m away. 
One dingo stayed at a distance of 10m while the other approached the 9 year old and began circling at a 
distance of <2m. The 9 year old then began to run from the dingo and was told to stop running by the 13 
year old. At this point the Girls' grandparents ran and intervened by scaring the dingo away. both 
dingoes left the area after the grandparents intervened. 
 
 
Additional comments and notes:       
 
 
Action taken: Family interviewed and briefed. Report Generated/circulated. SR FI, SR MUST & FC 
principal ranger notified rangers in area notified and asked to make families in the area aware of this 
situation. 
 
 
 
Proposed further action: Ensure families camping in Poyungan, Wongai, Guluri and Eli Camp Zones 
are aware that a dingo in this area is showing this behaviour and to be vigilant in supervising their 
children. 
 
 
 
Faxed/emailed date:  25/09/2014                               Reporting Officers details:  7026936 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Blue White Red 13 M  
 
Date (of Interaction): 24/9/14 
Location (of Interaction): Happy Valley 
beachfront 

Time (of Interaction 24hrs): 1730 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When people left the area 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: one of the dingoes was tagged 
 
d. Which ears were tagged Left 
    Details: Blue White Red 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Resort Guest      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments  See additional comments and notes 
 
 
 
Detailed report of events: and her partner were sitting near the waters edge whilst their Two 
children (12yo boy & 10yo girl) played 3m away, in front of Happy Valley at 1730 on the 24/9/14.
noticed Two dingoes approaching, One dingo stayed approx 10m away whilst the other dingo "trotted" 
towards her 12 year old son and circled around him within 1m. son then began to run away 
from the dingo which then gave chase, and her partnered told their son to stop running. When 
the boy stopped running the dingo growled and bared its teeth, at this point a vehicle drove up to the boy 
and the driver along with the passenger hoped out and scared the dingo off. 
 

and her family then walked back into the fenced area at Happy Valley 
 
The 12 year old boy involved in the interaction told ranger 7026936 that the dingo was tagged in its left 
ear with the colours Blue White & Red on it. The second dingo stayed too far away to see if it was 
tagged.  
 
 
 
 
 
 
Additional comments and notes: Family were following dingo safe messaging by keeping the children 
close (<3m) and telling their son to stop running when the dingo began circling him. However, if the 12 
year old boy had not run when he was being circled, the dingo may not have interacted further 
 
Reported to rangers by the Happy Valley resort at 0800 on 25/9/14 
 
 
 
 
 
Action taken: Family interviewed and briefed. Report Generated/circulated. SR FI, SR MUST & FC 
principal ranger notified rangers in area notified and asked to make families in the area aware of this 
situation. 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  25/09/14                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified 
 
Date (of Interaction): 28/9/14 
Location (of Interaction): Waddy Point 
Beachfront Camping zone 

Time (of Interaction 24hrs): Approx. 2130 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and his daughter were asleep when a dingo ripped their tent to gain 
access to food stored within the annex. daughter heard the dingo rustling in the tent and woke 

up. got out of the tent and chased the dingo off.  
 
The dingo gained access to a food container and took some biscuits.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Interaction report generated and circulated, Family briefed on dingo safety, SR Fraser 
Island & SR MUST notified by phone. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingo activity in the area; brief all camps on dingo safety & food 
security.  
 
 
 
 
 
Faxed/emailed date:  29.9.2014                               Reporting Officers details:  7027118 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Green Tagged Male 
 
Date (of Interaction): 01/10/2014 
Location (of Interaction): Burad CZ BF 

Time (of Interaction 24hrs): 08:30 
Reporting Officer/s details: 7026944 & 7029188 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 2m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Vehicle came between dingo 

& people 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 1             

 
c. Were the dingo(s) tagged Yes 
    Details: Green 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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 2 

Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: and his 9year old grandson were walking along the beach in front of 
Burad Camp Zone. 
 
They were looking for pippies when a green tagged male dingo came up to them and hunched down 
about 2m away from them. 
 

tried to get the dingo to leave however was unsuccessful until a vehicle drove between the dingo 
and and his grandson. 
 
The dingo followed them from the beach back to their campsite. 
 
 
 
Additional comments and notes: A green tagged male has been frequenting this area and has been 
identified from previous photos/interactions as PuGR13m. 
 
 
 
Action taken: Reported to NMU rangers.  Report compiled and circulated. 
 
 
 
Proposed further action: Monitor behaviour of all known dingoes in this area.  Continue with 
camper/visitor briefings.  Consider closing this camp zone if interactions/dingo behaviour continues in 
this area. 
 
 
 
Faxed/emailed date:  1/10/14                               Reporting Officers details:  7026944 & 
7029188 
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Dingo Interaction Report Form Insert Code: D Dingo ID:  BBR10m 
 
Date (of Interaction): 3 Oct 2014 
Location (of Interaction): Bingih sandblow- 
Waddy Point 

Time (of Interaction 24hrs): 07:00 
Reporting Officer/s details: 7027112 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) Within 2m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Continued to follow until 

reaching south waddy beach - then lost 
interest and left on its own accord. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: BBR10m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Germany 
Phone #:
Age:       
Email
 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments Not enough information supplied to dingo ranger to assess the situation. 
 
 
 
Detailed report of events:  
Ranger 7027122 obtained the following report at 8.30am 3/10/2014. 
 

and four other campers from Waddy Top camp ground were walking from camp over 
Bingih sand blow to South Waddy beach. 
•Half way across the blow around 7.00am on the 3/10/2014 they were confronted by what they 
described as an "excited but playful" Dingo (photos below). 
•They reported it as having a Pink tag in the left ear. 
•The dingo came within two metres of them and began to dominance test the group (photo1).  

described this behaviour as "played around", 
•They felt uncomfortable and proceeded to gather sticks for protection. 
•The dingo then followed the group the rest of the walk until they reached South Waddy. 
•The dingo eventually lost interest and left on its own accord. 
 
 
 
Additional comments and notes: Photographs taken during the interaction by have been 
analysed by dingo rangers. The dingo involved in interaction has been identified to be BBR10m. 
Although the description of the dingoes behaviour was reported as  "excited and playful" this was 
assessed as a dominance test.  
 
Dominate/submissive testing – often described as playful behaviour, prominent amongst younger 
animals. Animal/s will approach close to humans (<5 metres) and may jump around and yap and nip in 
an excited manner. Aggression from the animal may escalate if people respond inappropriately such as 
running away. ‘Can include growling, snarling and stalking’.   
 
 
Action taken: Waddy Rangers have been made aware of the event, dingo safe briefings and patrols of 
the Waddy Point beach area, supervisors notified, preliminary report sent 3/10/14. 
 
 
 
Proposed further action: Contine patrols and educational briefings of this area. 
 
 
 
Faxed/emailed date:  Prelim-03/10/2014      Reporting Officers details:  7026466, 7027118 
Report sent 14/10/2014 after unsuccessful attempts to re contact persons involved for 
further clarifiaction of events. 
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Photos  

 

Photo 1. 
BBR10 dominance test - 
Taken by 
during the interaction on 
the 3/10/14 
 
This photo indicates that 
the dingo has approched 
the group of people in a 
dominant manner with 
intent to test their 
response. 
 

 

Photo 2. 
Taken by 
during the interaction on 
the 3/10/14      
 

 

Photo 3. 
Taken by 
during the interaction on 
the 3/10/14      
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 4 

 

Photo 4. 
Taken by 
during the interaction on 
the 3/10/14 

   

Photo 5 & 6. 
BBR10m Delaminated tag 
- spike all red(outer ear), 
button pink (inner ear) 
 
 
Photo cropped from 

photograph's - 
taken during interaction on 
the 3/10/14. 
 

 

 

Photo 7.  
BBR10m identified on the 
southern Orchid Beach 
firebreak on the 1.09.2014 
 
Photo taken by ranger 
7027118 
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 5 

 

Photo 8.  
BBR10m identified on the 
southern Orchid Beach 
firebreak on the 1.09.2014 
 
Photo indicates delaminated 
tag – Spike red (outer ear), 
Button pink (inner ear). 
 
 
Photo taken by ranger 
7027118  

 

Photo 9.  
BBR10m identified on the 
southern Orchid Beach 
firebreak on the 1.09.2014 
 
 
 
Photo taken by ranger 
7027118 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified dingo 
 
Date (of Interaction): 10/10/14 to 13/10/1410/14 
Location (of Interaction): Maheno CZ 

Time (of Interaction 24hrs): 2200
Reporting Officer/s details: 7027848  
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  Other (specify) when dingo was yelled at 

and a torch light was pointed towards the 
dingo.  
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults             1 
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: Large, well built dingo  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Nerang 4211 
Phone #:
Age: 30 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Between 10/10/2014 to 13/10/2014 and her family were 
camping at the Maheno camping area.  
 
During their stay they regularly noticed two dingoes walking by their camp and occasionally loitering 
nearby. 
 
Over the following nights a dingo would approach their tent, unzip the canvas annex entrance and try to 
push its way through the fly mesh.  
 

and family would yell at the dingo and shine their torches in its face until it was scared away. 
 

and family were in their tent at the time the dingo would try and force entry.  
    
 
Additional comments and notes: The dingo did not take any food/rubbish.  
 

husband described the dingo involved with the interaction as being a healthy, large and a 
well-built.  
 
A dingo also urinated on the side of their canvas annex. 
 
No tag or further identification was recorded.  
 
 
Action taken: Interview conducted. Reported generated and circulated. Dingo ranger and NRM RIC 
notified. 
 
 
Proposed further action: Continue camper briefings and monitoring throughout the area. 
 
 
Faxed/emailed date:  16/10/14                                   Reporting Officers details:  7027848  
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: BWR13m & UT female 
 
Date (of Interaction): 13/10/2014 
Location (of Interaction): Poyungan CA 
beachfront 

Time (of Interaction 24hrs): 06:00 
Reporting Officer/s details: 7028018 & 7028728  
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult 1 1       
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWR13m tagged and untagged female 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:
Address:       
Phone #
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 

 
Detailed report of events: On the 13/10/2014 at approx. 06:00, and were 
walking along the beach adjacent to the Poyungan camping area and were approched by two dingoes. 
 
The dingoes were described by as 1 male tagged in the left ear with a red, white and blue 
tag (BWR13m) and an untagged female, both looking approx. 1 years old. 
 

shouted at the two dingoes in an attempt to deter them but the dingoes responded by 
showing their teeth. 
 

continued to try and deter the dingoes by kicking sand. The dingoes left of their own 
accord after 5 minutes.  
 
 
Additional comments and notes: had not recieved a ranger dingo safety brief and were 
unaware of dingo safe messaging recommendations to carry a walking stick.  
 
BWR13m is a known habituated dingo and has previously displayed threatening and high risk behaviour.  
 
No photos were taken of the two dingoes.  
 
 
Action taken: Interview conducted. Report generated and circulated. Dingo ranger and RIC NRM 
notified.  
 
 
Proposed further action: Continue ranger camp area patrolling and visitor briefings. monitor and 
record or dingo activities in and around the Poyungan area. 
 
 
Faxed/emailed date:  17/10/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Pu GR13m 
 
Date (of Interaction): 21/10/14 
Location (of Interaction): Marloo CZ 

Time (of Interaction 24hrs): 6.00 
Reporting Officer/s details: 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) <2m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) <2m 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Waving hat around 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1       1 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: 1 dingo, other unidentified 
 
d. Which ears were tagged Left 
    Details: PuGR13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Dark colouration along the back 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Traveston, 4570 
Phone #:
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments They had camped on Fraser Island and was aware of dingo issues. She will be 
walking with a stick and not walking alone in future. 
 
 
 
Detailed report of events: On Tuesday the 21st of October at 6.00, was walking along 
the beach 300 metres from the northern end of Marloo CZ and encountered 2 sub adult dingoes. One 
had a green tag in the left ear and was dark in colouration and the other was unidentified as it stayed 
high up in the dune. The male, green tagged dingo was the aggressor as it circled and stalked
pushing her towards the water, until she was knee deep in the water. The dingo got within 2 metres of 

growling and asserting its dominance by pushing her into the sea. This persisted for 5-10 
minutes, with waving her hat and yelling at the dingo and eventually the dingo became 
disinterested. The two dingoes then headed south.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The description is consistent with PuGR13m who has been ranging 
between Wyuna Ck and Ocean Lake. 
 
 
 
 
Action taken:  Report generated and RIC, 2IC, SR and dingo ranger advised 
 
 
 
 
 
 
 
 
 
Proposed further action: Continued camper briefings and advise visitors on dingo issues within the 
area 
 
 
 
 
 
Faxed/emailed date:  22/10/14                               Reporting Officers details:  7028773 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified dingo 
 
Date (of Interaction): 15/11/2014 
Location (of Interaction): Duling camp area 
beachfront 

Time (of Interaction 24hrs): 0900 
Reporting Officer/s details: 7028796 & 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) <5 m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) <5 m 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)  Onlooker drove vehicle 

between the dingo and people 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details: A tag wasn’t identified 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Dark ridge on back & light couloration 
on its flanks 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address Keperra 
Phone #
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Campers followed dingo safety messages but the dingo was persistant 
 
 
 
Detailed report of events: On the 15/11/2014 at approx. 0900 and his wife (name 
unspecified) were walking along the beachfront adjacent to the Duling camping area, when approached 
by a dingo heading south from  N'gkala Rocks. 
 
The dingo circled the couple, initially from a distance, and then moved in closer (less than 5 meters). 
 

and his wife became concerned for their safety when the dingo repeatedly stopped them from 
returning to their camp in the Duling camping area.  
 
The dingo then proceeded to herd them away from the Duling camping area, so and his wife 
retreated into the ocean for safety. The dingo followed them a short distance into the ocean as well. 
 
An onlooker saw the interaction and intervened by putting their car between the dingo and and his 
wife enabling them to return up the beach to their camp.   
 
No identifying features of the dingo such as an ear tag, gender, scars and sock markings were noticed 
by and his wife. No photos were taken.  
 
 
Additional comments and notes: No photos or identifying features of the dingo were noticed by 

and his wife due to their concerns for their safety. 
 
Although an exact age of the dingo wasn’t ascertained, described the dingo as being 
almost an adult and with dark colouring on its back and light flanks. This description is similar to sub-
adult dingo features.  
 
PRG13m regularly frequents this area and has a recorded management history of displaying threatening 
behaviour towards humans. 
  
 
Action taken: Interview undertaken and report generated and circulated. RIC NRM and dingo ranger 
notified. 
 
 
Proposed further action: Continue and increase ranger educational briefings on dingo safe messaging 
to all visitors in the area. Continue monitoring all dingo activities in the area.    
 
 
Faxed/emailed date:  15/11/2014             Reporting Officers details:  7028796 & 7028018 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified dingoes 
 
Date (of Interaction): 15/11/14 
Location (of Interaction): Burad camping area 

Time (of Interaction 24hrs): 1330 
Reporting Officer/s details:  7027848 & 7027202  
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  Other (specify) When a bull whip was 

cracked. 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults             2 
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: One dingo was described as large with 
dark markings on his back 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Maryborough 
Phone #
Age: 30 - 35 
 
 
Name:       
Address:       
Phone #:       
Age:       
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 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The children of the two families were kept close. 
 
 
 
Detailed report of events: On the 15/11/2014 at approx. 1330, his wife (name 
unspecified), another couple (names unspecified) and their children were having lunch on the back of 
their cars in the Burad camping area when they noticed two dingoes walking along the beach. 
 
The two dingoes focused their attention on the group and started to run towards them at a fast pace.  
 

took out his stock whip and cracked it a number of times. The cracks of the whip stopped the 
dingoes approx. a cars length away from the group. The dingoes continued down the beach. 
 
No identifying features of the dingoes such as an ear tag, gender, scars and sock markings were noticed 
by or by members of the group. No photos were taken.   
 
Additional comments and notes: Identification of the dingoes could not be obtained but one dingo was 
described as large with dark fur on its back.  
 
 
Action taken: Interview undertaken and report generated and circulated. NRM RIC and dingo ranger 
notified. 
 
 
Proposed further action: Continue ranger educational briefings on dingo safe messaging to all visitors 
in the area. Continue monitoring all dingo activities in the area.    
 
Faxed/emailed date:  16/11/14               Reporting Officers details:  7027202 & 7027848 
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Code D_Unidentified Dingo_Lake Wabby_24Nov2014_Growling 1

Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified Female 
 
Date (of Interaction): 24/11/14 
Location (of Interaction): Lake Wabby 

Time (of Interaction 24hrs): 10:30 
Reporting Officer/s details: 7028030 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 1 meter        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult       1       
Sub adult                   
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: orange (no further info) 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not supplied 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code D_Unidentified Dingo_Lake Wabby_24Nov2014_Growling 2

Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Grouped with another two persons and reported the interaction to Ranger. 
 
 
 
Detailed report of events: Ranger 7028030 was approached by two men who advised there was a 
female Dingo at the lake that was acting aggressively towards them. When they grouped with another 
two people to walk back to their cars, the dingo approached them, followed closely and started to growl 
at them. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Male person refused to supply details or further information. 
 
 
 
 
 
Action taken: Report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor area and attempt to identify this individual, continue to brief camps 
and patrols in the area. 
 
 
 
 
 
Faxed/emailed date:  26/11/14                               Reporting Officers details:  1423322 
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Code D_Unidentified Dingo_Lake Wabby_24Nov2014_Growling 3

Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Incident Report Form 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified 
 
Date (of Interaction): 05/12/14 
Location (of Interaction): 2.7 klms North of 
Poyungan Valley 

Time (of Interaction 24hrs): 17:30-18:00 
Reporting Officer/s details: 7028120/7028122 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age 1 1       

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: 1 Dingo was tagged in the right ear 
 
d. Which ears were tagged Right  
    Details: unknown 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:dark marking on back of both dingoes 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address Banyo, 4014 Qld 
Phone #
Age:       
 
Name:
Address: Clearwater, 
Florida 
Phone #:
Age:       
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Dingo Incident Report Form 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: was standing at the waters edge occasionally crouching down to 
collect pippies. His friends were approximately 200 metres up the beach. He became aware that the two 
dingoes were closing in on him. He started flicking water, shouting and keeping eye contact. The dogs 
were persistent and pushed into the water to knee deep. signalled his friends as the 
situation got worse. came down shouting and swinging a pvc pipe. It distracted the dingoes enough 
for to join shoulder to shoulder and proceed to chase the dingoes back up the beach. The 
two dingoes eventually proceeded up the beach to the North. The dingoes were continuing to stop and 
look back as they went up the beach. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: was staying at private accommodation at Fraser Island 
Hideaway 
 
 
 
 
 
Action taken: Report generated and circulated. 
 
 
 
 
 
 
 
 
Proposed further action: continue to brief campers and private accommodation in the area. 
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Dingo Incident Report Form 3 

Faxed/emailed date:  06/12/14                               Reporting Officers details:  
7028120/7028122 
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Dingo Incident Report Form 4 

Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Code D_BWPi13f_Eurong_BF_17Dec2014_growling 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: BWPi13f 
 
Date (of Interaction): 17/12/2014 
Location (of Interaction): Eurong Beach Front 

Time (of Interaction 24hrs): 0500hrs 
Reporting Officer/s details: 7027772 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 3m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) returned to fenced area 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults       1       
Sub adults                   
Juvenile             1 
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWPi 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Sunshine Coast 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code D_BWPi13f_Eurong_BF_17Dec2014_growling 2 

Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments is a regular visitor the island and is aware of the dingo safe message. 
 
 
 
Detailed report of events: approached Ranger 7027772 at Eurong Office and explained 
about this female dingos behaviour on the beach front at Eurong Resort. While filming the sunrise 
around 5am was approached by a female dingo with Blue White and Pink tag in her right ear, she 
was growling & dominance testing while her pup was a short distance away watching. threw a 
Cuttlefish bone which distracted her for a moment. and his wife then walked near a couple of 
backpackers because they were a bit scared themselves and they then proceeded back to Resort. The 
female dingo continued to follow the group all the way back to the Eurong gate. Ranger 7027772 
observed some footage of the dingos actions on camera. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Ranger 1423322 phoned and obtained further details of the 
interaction to complete report on 18 Dec 2014. 
 
 
 
 
 
Action taken: Notified RIC of NRM. Report generated and circulated.  
 
 
 
 
 
 
 
 
Proposed further action: Continue ranger beach patrols and camper and visitor briefings.   
 
 
 
 
 
Faxed/emailed date:  18/12/14                                              Reporting Officers details:  
7027772 
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Code D_ BWR13M_Eli Ck_20Dec14_Hunting tactics 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: BWR13m 
 
Date (of Interaction): 20/12/2014 
Site: Eli Creek DUA 
Detailed location: In Eli creek on the beach front 

Time (of Interaction 24hrs): 10:00 
Reporting Officer/s details: 1423322 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult 1             
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Red tag, unsure of other colours 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:unsure 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: ACT 
Phone #: mobile 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code D_ BWR13M_Eli Ck_20Dec14_Hunting tactics 2 

Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments and his family also stayed at Dundubura and received information there. 
 
 
 
Detailed report of events:  
At approximately 10am on the 20th December 2104 at Eli Creek day use area was 
watching his 3 year old son play in the water 3 meters away. 
His son stood up and ran across the creek; followed and observed a dingo approach at high 
speed from 30-40 meters away. 
His son was now about 10 meters away, he raced over and picked up his son as the dingo stopped 
within a meter. 

and two other adult males chased the dingo away but the dingo continued to loiter. 
Another dingo was loitering in the area but was not involved in the interaction.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: contacted the 13QGOV number at the end of December 
however the message was not received.  Email received from to follow-up on the interaction 
and NRM Rangers recorded the details. 
 
 
 
 
 
Action taken: Dingo hotline answering machine and number checked to confirm no further issues. 
 
 
 
 
 
 
 
 
Proposed further action: This dingo has been euthanised as a result of multiple negative dingo/human 
interactions. 
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Code D_ BWR13M_Eli Ck_20Dec14_Hunting tactics 3 

Faxed/emailed date:  06/01/15                               Reporting Officers details:  1423322 
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 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: BBR10m 
 
Date (of Interaction): 21.12.2014 
Location (of Interaction) Orchid 
Beach Fraser Island 

Time (of Interaction 24hrs): 0540 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: Red/Pink - Identified to be BBR10m  
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:High left sock, white tail tip 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:   
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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 2 

Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Very aware of dingo safety. 
 
 
 
Detailed report of events: Sunday morning a male dingo was walking past the house up on the 
boarded track. I opened the wooden door (so screen door still closed) to show the kids what a 
dingo looked like. As soon as it saw us it walked straight towards the door and laid down (seen in photo 
1). It then approached closer and started to yip and bounce around like it wanted to play (photo 2 and 3). 
We made no encouraging movements and it was not scared of us at all.  
 
It had one final lunge towards the door then trotted off down the southern side of the house with tail 
curled high in the air. It left the property
 
It was a male with a tag in its left ear. The tag was all either faded red or pink. It had a distinctive high 
left front sock (seen in photos). Had a fluffy tail with a white tip. 
 
 
 
 
Additional comments and notes:  

 Photos of the animal involved in this interaction have been analysed by a Dingo ranger. The ID of 
this dingo is consistent with BBR10m. BBR10m was involved in a Code D incident on the Bingih 
sand blow at Waddy Point on the 03.10.14 

 
 Holiday season dingo safe message information packs were delivered to township houses on the 

19.12.2014. 
 
 
Action taken:  Talked with family involved, Supervisors notified, Report generated and circulated. 
 
 
 
 
Proposed further action: Monitor the area and ensure all families are briefed on dingo safety 
throughout the holiday period. 
 
 
 
 
 
Faxed/emailed date:  22/12/2014                                  Reporting Officers details:  7027118 
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 3 

Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  Photo taken by 

during interaction 
21.12.14 
 

Photo 2. 
Description (who took 
photo/when):  BBR10m 
displaying dominance test type 
behaviour. Photo taken by 

during interaction 
21.12.14 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 201 of 231



 4 

 

Photo 3. 
Description (who took 
photo/when):  Photo taken by 

during interaction 
21.12.14 
 

Photo 4: Photo taken by during interaction 21.12.14 
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 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: 2 Unidentified Dingoes 
 
Date (of Interaction): 22.12.2014 
Location (of Interaction): Marloo camping zone 
Fraser Island 

Time (of Interaction 24hrs): 0640 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) <2m 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When nearby camper came 

and helped 'shoo' the dingoes off. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             2 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Walking alone not recommended. 
 
 
 
Detailed report of events:  

 Monday morning 22.12.14 at approximately 6.40am was walking on the beach 
400m north of her camp in Marloo cz.  

 noticed two dingoes on the dune adjacent to her. 
 Initially one of the dingoes approached within 2 meters of her, preventing her from walking 

forward 
 The second dingo then approached and circled behind her  
 tried to deter the animals with a stick - though was not effective 
 The two dingoes continued to circle until a lady from a nearby camp came to assist and chased 

the dingoes away. 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
Action taken: Supervisors notified, report generated and circulated 
 
 
 
 
Proposed further action: Brief all camps between Waddy Point and Nkgala rocks throughout the 
holiday period. Continue to monitor dingo presence in the area.  
 
 
 
 
 
Faxed/emailed date:  23.12.2014                                 Reporting Officers details:  7027118 
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Code D_GGG13f_Eli Creek_21Dec2014_Ambushing  1 

Dingo Interaction Report Form Insert Code: D Dingo ID: GGG13F 
 
Date (of Interaction): 21/12/14 
Location (of Interaction): Eli Creek 

Time (of Interaction 24hrs): 1000 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult       1       
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Upper Coomera 
Phone #:
Age: 41 
 
Name:
Address:       
Phone #:       
Age: 12 
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Code D_GGG13f_Eli Creek_21Dec2014_Ambushing  2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Two men were able to intervene before the dingo reached 
 
 
 
Detailed report of events: A 12 year old girl was playing in Eli Creek approximately 30m from her 
family on the creek edge. Her parents noticed two dingoes wandering through visitors parked beside the 
creek, they then sat in the creek approximately 30m from their daughter. Two of the men that were with 
this family noticed one of the dingoes start to run towards the 12 year old girl. Both men ran and put 
themselves between the dingo and the girl. The dingo then began displaying dominance testing 
behaviour for a short time, then went back to lay in the creek with the other dingo. The men that 
intervened said that the dingo involved had a Green tag in its right ear, the other dingo had a Blue, White 
and Red tag in its left ear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken:  Interview undertaken, report generated and circulated. SR FI notified.   
 
 
 
 
 
 
 
 
Proposed further action: Continue and increase ranger educational briefings on dingo safe messaging 
to all visitors in the area. Over busy period, conduct early and late patrols between Poyungan Rocks and 
Eli Creek. Continue monitoring all dingo activities in the area. 
 
 
 
 
 
Faxed/emailed date:  22/12/14                               Reporting Officers details:  7026936 
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Code D_GGG13f_Eli Creek_21Dec2014_Ambushing  3 

Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09

15-166 File D 207 of 231



Code D_Unidentified dingo__Marloo CZ Beachfront_26Dec2014_Circling 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified 
 
Date (of Interaction): 26/12/2014 
Location (of Interaction): Connors Corner to 
Ngkala Rock 
Detailed Location: Marloo CZ beach front 

Time (of Interaction 24hrs): 15:00 
Reporting Officer/s details: 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) 5m 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Vehicle chased dingo away 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Bribie Is. 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code D_Unidentified dingo__Marloo CZ Beachfront_26Dec2014_Circling 2 

  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Went to great effort to research 'Dingo Safe' behaviour prior to visiting Fraser Is. and 
children had been given whistles to alert parents in the event of a dingo interaction. 
 
 
 
Detailed report of events: and 5 children were playing in the water at the North end of Marloo 
Camp Zone. observed a dingo traveling from the north along the beach then the dingo increased 
pace towards them. When it was alongside them tried to scare the dingo by yelling and waving his 
arms. The dingo proceeded to dominance test, growl and snarl whilst circling within 5 meters, the dingo 
also got low in the water and was watching the children. was still trying to scare the dingo away 
when two vehicles pulled-up and a lady got out attempting to take photographs. The dingo ran at the 
lady who retreated to her vehicle. The vehicles left south along the beach and the dingo followed 
allowing and the children to return to their camp site. 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: SR advised, report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: Continue to brief members of the public and place camera traps and attempt 
to identify dingo. 
 
 
 
 
 
Faxed/emailed date:  31/12/2014                               Reporting Officers details:  7028773 
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified dingo 
 
Date (of Interaction): 27 December 2014 
Location (of Interaction): Eli Creek beachfront 
(southern end) 

Time (of Interaction 24hrs): 1700hrs 
Reporting Officer/s details: 7026462 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance) 1m 
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult             1 
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Darker fur 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Intervener 
Address: Coalfalls 4305 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: Camper reported the following at approximately 1210pm 29/12/14 whilst 
rangers were undertaking patrol - 
Man had been visiting Eli Creek at approximately 1700hrs on 29/12/2014 when he observed a dingo 
lying on the higher bank at the southern end of the creek. The dingo howled and then appeared to 
consume something. Another dingo appeared and they briefly interacted with each other with some 
rough and tumble play before separating. The second of the dingoes made a beeline for the son of 
reporting person (21 y.o. who was lying or sitting in the water but stood up) then diverted attention to two 
teenage girls (approximately 16 years old) who were walking along the beach and began circling them 
within two metres. The observing man intervened at this stage by running at the dingo with a stick held 
up and then striking the sand with the stick. The man claimed that he could have struck the dingo if he 
wished to. The dingo remained unidentified throughout the interaction but took a step back, standing its 
ground. A vehicle came along, picked up the two women, and left the scene.  
The first dingo remained up on the bank and did not participate in the interaction with persons. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Media enquiries received recently may relate to this interaction? 
 
 
 
 
 
Action taken: Reported incidentally, not proactively by campers. Left message on Fraser Island S/R 
phone 1218hrs and reported verbally to a/Principal Ranger 1220hrs and Eurong dingo ranger 1258hrs. 
 
 
 
 
 
 
 
 
Proposed further action: Continue intensive monitoring and patrols of site and adjacent areas, 
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maintain temporary closure of adjacent camping zones. 
 
 
 
 
 
Faxed/emailed date:  29.12.2014                               Reporting Officers details:  7026462 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 Release
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Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified dingo 
 
Date (of Interaction): 27 December 2014 
Location (of Interaction): Happy Valley 
beachfront 

Time (of Interaction 24hrs): 1830hrs 
Reporting Officer/s details: 7026462 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 10m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) vehicle intervention 

attempted, dingo followed persons back 
towards Happy Valley fenceline 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Yes 
    Details: Left ear, no colours identified 
 
d. Which ears were tagged Left 
    Details: No colours identified 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Not described 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Witness - 
Address: Booral 4655 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments No details available of persons involved in interaction 
 
 
 
Detailed report of events: was driving along the beach in front of Happy Valley when he 
observed a dingo with a tag in its left ear (colours unspecified) charging at two persons walking along 
the water's edge. attempted to drive his vehicle between the dingo and the persons, but the 
dingo persisted, not backing down and lunging at (but not attempting to bite) the couple.
offered the persons a lift back to within the fenced Happy Valley area - this was declined, and 
observed the couple walking back towards the Happy Valley fence with the dingo following closely 
behind them. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: stated that there was another unidentified dingo nearby, 
but that it was not involved in the interaction. GGG13f and BWR13f are known to frequent this territory 
and have demonstrated escalated behaviour in recent months. 
 
 
 
 
 
Action taken: Delayed report from interveners (29.12.2014). Reported through chain of command. 
 
 
 
 
 
 
 
 
Proposed further action: Maintain adjacent camping zone closures, improve signage regarding 
recreating (especially jogging) on the beach, consider temporary closure of Eli Creek day use area 
 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Faxed/emailed date:  30/12/2014                               Reporting Officers details:  7026462 
through 7026804 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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1 

Dingo Interaction Report Form Insert Code: D Dingo ID: Unidentified dingo 
(possibly untagged) 
 
Date (of Interaction): 28.12.2014 
Location (of Interaction): Beachfront, Gabala 
camping zone 

Time (of Interaction 24hrs): 1930hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Described as 'smaller' 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name
Address: Wife 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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2 

  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: Wife of man involved in interaction reported through 13 74 68 
hotline the night of the interaction. From: a_ciboodleautoreply@smartservice.qld.gov.au 
[mailto:a_ciboodleautoreply@smartservice.qld.gov.au]  
Sent: Sunday, 28 December 2014 8:12 PM 
To: QPWS 
Subject: Smart Service referral 
 
Enquiry Reference Number: 41433323 
Referred Time: 20:11 
Referred By: schenkm 
Related Script: Camping Services 
 
 
Name: * 
 
Booking number:  
 
Customer ID:  
 
Phone: *
 
Alternative phone:  
 
Email: *
 
Address:  
 
Message: * Caller would like to report a dingo which harrassed her husband which occurred this 
evening. There were backpackers who left food behind which bought dingoes into area. Thanks.. 
 

had been on the beach, near the water's edge and was squatting down when his fellow 
campers observed a dingo bolting down towards him. They attempted to yell out to alert to the 
dingo's presence, but he did not hear them over the sound of the surf and wind. Incidentally, stood 
up just as the dingo reached him, at which point the dingo stopped, briefly circled who at this 
point realised that the dingo was there) and shone a torch at the dingo but did not notice an ear 
tag. Another camper ran down to the beach with a golf club, chasing the dingo away.  
 
 
 
Additional comments and notes: stated that the previous night, some campers in a Fraser 
Dingo 4WD hire vehicle had camped next to them, allegedly burying rubbish which a dingo had evidently 
dug up (so they were being attracted to the area).  
 
 
Action taken: Called and spoke to reporting camper Report generated and distributed. 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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3 

 
 
 
Proposed further action: Continue camp patrols and briefings. 
 
 
 
 
 
Faxed/emailed date:  30.12.2014                               Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: Code D Dingo ID: Unidentified dingo 
 
Date (of Interaction): 29/12/14 
Location (of Interaction): Happy Valley 
beachfront (500m north) 

Time (of Interaction 24hrs): 0520 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When jogger left in car 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Current interperative material suggests that jogging will attract the attention of 
dingoes. This material also suggests that if visitors must jog, they should carry some sort of 
deterrent. 
 
 
 
Detailed report of events: was travelling south towards Happy Valley at 0520 on the 
29/12/14 with Two others. He noticed a Jogger being ambushed by a dingo. drove his vehicle 
towards the dingo to deter it from the female jogger who soon after entered the vehicle. The Lady was 
taken back to her vehicle in front of Happy Valley 500m to the south.  
 
This interaction was captured on video by a camera mounted on the front of vehicle. The video 
shows the dingo approaching the jogger quickly from behind (to within 1m) while she tries to move away. 
The video quality is too poor to gain identification or sex of the dingo. and his friends could not 
positively identify or sex the dingo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Ranger 7027146 gathered report from whilst briefing 
camps in Maheno CZ. Video of interacion is stored on Eurong G:\ 
 
 
 
 
 
Action taken: Report generated and circulated, SR Fraser Island notified 
 
 
 
 
 
 
 
 
Proposed further action: Patrol from 0500 untill 1830 will be carried out by rangers. Regular presence 
should be maintained between Happy Valley and Eli ck throughout day, given the behaviour of dingoes 
in this area. 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Faxed/emailed date:  30/12/14                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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 1 

Dingo Interaction Report Form Insert Code: D Dingo ID: BWR13M 
 
Date (of Interaction): 30Dec14 
Location (of Interaction): Eli Ck 

Time (of Interaction 24hrs): 1615 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When hit in rump with a hand 

full of wet sand 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWR13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: RBAC Tour Guide 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   commercial tour operator      
Did they receive an information pack with their permits Yes 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At approx. 1615hrs ranger 7027330 was patrolling Nth through Eli creek 
when a lone adult male visitor was seen walking from the dune toward the sea. The visitor then ran the 
last 10-15m to the water and dove in. When the visitor began to run a dingo ran up behind him and 
followed him into the water. When the visitor turned around the dingo continued toward him up to its 
chest in the water preventing him from leaving the sea. At this point ranger 7027330 hit the dingo in the 
rump with a handful of wet sand and the dingo retreated Sth. The visitor identified himself as

an RBAC tour guide and was visibly shaken. The dingo was followed to Eli Ck and was 
positively identified as BWR13M and photographed. GGG13F then appeared and with BWR13M began 
scavenging around the car park area. Both animals headed Sth at approx. 1700hrs.  
  
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Both animals were travelling from Nth to Sth. 
 
 
 
 
 
Action taken: Monitor animals, briefed daytrippers in the area especially those with children, 2IC 
Dundubara informed, SR Fraser informed, generate report. 
 
 
 
 
 
 
 
 
Proposed further action: Continue patrolling and briefing regime, investigate closing area to food prep 
and consumption 
 
 
 
 
 
Faxed/emailed date:  31/12/14                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7027330 1620hrs 
30Dec14 Eli Ck 

 Photo 2. 
Description (who took 
photo/when):  as above 
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Dingo Incident Report Form Insert Code: D  Dingo tag: Green Green 
Green 2013 female 
 
Date (of incident): 30/12/14 
Location (of incident): Eli Creek boardwalk 

Time (of incident 24hrs): approx 1015hrs 
Reporting Officer/s: 7027146 & 7027334 
Base: Dundubara 

Question 1: What were the actions of the dingo(s) 
during the incident?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the incident 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG 13 f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo incident. 
 
Name: Witnessed by Ranger 7027146 and 
7027334 
Address: Fraser Island 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people respond appropriately to the incident? (Ranger to assess) Unknown 
Comments The male that was the subject of the incident was not able to be interviewed as he had 
already left the area by the time Rangers left the creek. 
 
 
 
Detailed report of events: (Rangers 7027146 and 7027334 were conducting camper briefings and 
patrols in the Maheno camping zone when given information that GGG13f (and another male dingo) 
were seen running through the back of the camping zone approximately 20 minutes earlier. The 
campers being briefed reported seeing these two dingoes at other times during their stay. Rangers 
travelled to Eli Creek following the campers indicateing that the dingoes had been chased away from 
their camp and they headed in the direction of Eli Creek.)  
 
* A commercial tour operator driver indicated that he was present at Eli Creek edge when two dingoes 
(one of which he identified as GGG13f) approached the creek from the north and ran straight toward 
some visitors that were a little further along the creek than himself. He believed that they were cooking a 
BBQ and this is why they approached them. He states that they were chased away and they headed up 
toward the boardwalk. 
* 7027146 and 7027334 went along the boardwalk and after a short while located GGG13f. 
* GGG13f was observed standing on the southern side of Eli Creek bank and looking at the visitors 
swimming past her. She had an erect posture with tail raised. Her posture suggested that she was 
poised to lunge at something. 
* This dingo then made several lunges toward a large male adult that was floating past in the creek.  
* The dingo then lunged again and entered the water toward the male visitor. 
* The visitor yelled at the dingo and attempted to kick it away from him. 
* The dingo exited the creek on the southern side and continued to move along the creek bank in the 
cover of the trees while Rangers attempted to move it away from people in the creek. 
 
* The dingo eventually crossed the creek and moved off to the north. It was not sighted again by 
7027146 and 7027334. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Blue White Red Male 2013 was also seen in the immediate vicinity 
of Eli Creek when Rangers arrived but was not sighted in conjunction with this incident. 
 
 
 
 
 
Action taken: Notified SMU RIC and NRM staff 30/12/14.  
Maintained on-site observation of this dingo by standing on the creek bank alerting swimmers to the 
potential danger. 
7027146 and 7027334 left when SMU Rangers arrived and took over. 
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 3 

 
 
 
 
 
Proposed further action: Refer NRM 
 
 
 
 
Faxed/emailed date:  31/12/14                                                        Officer:7027146 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the View Tab – then scroll down to Toolbar and 
select Forms. The Form toolbar will display – click the lock icon. You can now insert a picture using the Insert tab.   
 
         Photo 1. 
         Description (who took photo/when):
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
         Photo 2. 
         Description (who took photo/when): 
               
 
 
 
 
 
 
 
 
 
 
 
 
 
                               Photo 3. 
         Description (who took photo/when): 
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